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The electronics industry moves fast and embedded developers are often required to implement
feature-rich products with short design cycles. Product requirements often change over the course
of development, and, while most product managers are hopefully not as impractical as Dilbert’s
pointy-haired boss in the above cartoon, embedded developers are often required to react quickly
to an ever-changing electronics marketplace.
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Module Topics

What is DaVinci™ Technology?

Devices
Software
Tools
Support

TMS320DM643x and ‘DM644x

Codec Engine, BIOS, NDK, Codecs
DM643x DSK, Code Composer Studio
Approved Software Providers (ASP)

Application Layer

» User Interface §
» Processing Thread (s) é

» Network Services (NDK)
» Other

EPSI API

Operating System Layer (DSP| =

(Dsp

TEXAS INSTRUMENTS

....

4t sol

7
| (g tantine

@ !c';hm)i'ugics

TECHNOLOGY

MHAEDINWORKS

With all of the challenges facing them, embedded software developers cannot afford to reinvent
the wheel on every design. A powerful and robust software framework is required to enable rapid
prototyping and reliable long-term performance. This is why Texas Instruments’ DaVinci
Technology encompasses not only a series of highly integrated multimedia processors but a
production quality framework, a number of easily integrated third-party algorithms and a
powerful development and debugging toolset.
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DaVinci Family Devices

DaVinci Family Devices

Different Needs? Multiple Families.

Efficiency

Best MIPS per
Watt / Dollar / Size
« Wireless phones
« Internet audio players
Digital still cameras
« Modems
Telephony
« VoIP

*

*

TO

Technical Trining
Organization

First Complete Video Platform

Device &
A @ Announced < DaVinci
 DM647/8 Davinci
() New1Qo7 2 Devices DM6467
o Fuure e $39.95 - $65.95 64
* New CB4x+™ Core 20 Samples 2Q07 Sampling
Al pricing at 10Ku ,\0\‘“ Production Q407 4Q07
et
5 DM643/2/1/0 _ S Davinci
§ 4 Devices Integration Devices DM6441
Hundreds of ~ Co $24.95 - $34.95 4.95
cL:Jstomers St e, In Production Order Now
Millions of Oci/b
units sdhipped n
o date DaVinci Davinci
$18.95 - $52.79 DM643x* AL
In production 4 Devices
since mid-2004 $9.95 - $22.00 $9.75
Samples Now Sampling 3Q07
Production 3Q07
2002 Time 2007
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DaVinci Family Devices

TMD320DM6446: Arm + DSP

¢ DM6446 Ixiad;i:'g Video Processing Subsystem

Coprocessor

ARM DSP

Switched Central Resource (SCR)

Peripherals Connectivity

UsB EMAC 2
= 20 |VLYNGQ || with g
PHY MDIO el

Serial Interfaces Program/Data Storage

DDR2 || Async EMIF/]| ATA/
Controller| | NAND/ | Compact | MMC/
(16b32b) | SmariMedia| Flash™

TMS320DM644x in Production Now

ot

et £ .
cc:\:a“‘_‘"?' DM6443 DM6446 DM6441
3 \_I:J)SP' TMS320C64x+™ TMS320C64x+™ TMS320C64x+™
e 600 MHz 600 MHz 405/513 MHz
ARM ARM926EJ-S™ ARM926EJ-S™ ARM926EJ-S™
300 MHz 300 MHz 202/256 MHz
Video Processing Back End AND Back End AND

Back-end ONLY

Subsystem (VPSS) Front-end Front-end
Video-Imaging
Coprocessor No Yes Yes
(VICP)
Dual voltage & No No 1 ““"\’(iT)SMHz
Clock Scaling 1.2V core voltage | 1.2V core volts

513MHz

>35%
Power
~ Reduction

DaVinci 1-Day Workshop - Introduction 1-5



DaVinci Family Devices

TMS320DM6437: DSP Only

X3 DM6437

DSP Subsystem

L1D 80KB

C64x+™ DS
600-MHz
Core

= L2
128 KB
Cache

L1P 32KB

Peripherals

CCD Controller
Video Interface

Back End

Video Processing Subsystem

ogram/3A

Resizer

Video

10b DAC

Ene | 10bDAC
(VENC) |_10bDAC
10b DAC

Switch Fabric

Connectivity

TMS320DM643x Sampling Now

pin 1O°
=\ o\e
6431 DM6433 DM6435 DM6437
(_@GF' TMS320C64x+™ TMS320C64x+™ TMS320C64x+™ TMS320C64x+™
i 300 MHz 600 MHz 600 MHz 600 MHz
l DDR2 - 266 MHz DDR2 - 266 MHz DDR2 - 266 MHz DDR2 - 266 MHz
(16b) (32b) (32b) (32b)
1x Video Port Back-end AND
VPSS (10b) Back-end ONLY Front-end ONLY Front-end
L1/L2 64KB L2 128KB L2 128KB L2 128KB L2
32K L1P /32K L1D | 32K L1P /80K L1D | 32K L1P /80K L1D | 32K L1P /80K L1D
VLYNQ PCl or VLYNQ
EMAC or EMIF PCl or VLYNQ
IIF MCASP, I7G. CAN, SPI, EMAC, HP1 of EMIF po R o
QAR MCASP, I?C, SP! v UART(2) | rc, CAN, SPI, UART (2)
G
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DaVinci Family Devices

TMS320DM647/8: Multiple Video Ports

X3 TMS320DM648

EDMA 3.0

Video Acceleration

DSP Subsystem

L1P 32KB
Co4x+™

.
DsP 512KB
L1P 32KB
Lol bl

Switched Central Resource

Video
Port
x5

Peripherals System  Program/Data Storage
Time
64-bit
*2

Connectivity

Pl
PCI-66
or

Serial Interfaces

McASP
E

TMS320DM647/8
DM647 DM648
(DsP TMS320C64x+™ |  TMS320C64x+™
TS TS 900 MHz 900 MHz
! DDR2 - 533 MHz DDR2 - 533 MHz
(32b) (32b)
. 5 16-bit Dual 5 16-bit Dual
Video Ports Channel Channel
L1L2 256KB L2 512KB L2

32K L1P /32K L1D

32K L1P /32K L1D

Dual voltage &
Clock Scaling

PCl or UHPI
Gigabit EMAC x2 + Switch
MCASP, I2C, SPI, Timer (2)

PCl or UHPI
Gigabit EMAC x2 + Switch
MCASP, I2C, SPI, Timer (2)
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DaVinci Family Devices

TMS320DM6467: High Definition Video

Features
B Core
+ ARM926EJ-S™ (MPU) at 300 MHz
+ TMS320C64x+™ DSP Core at 600 MHz
B Memory
+ ARM: 16K [-Cache, 8K D-Cache, 32K TCM RAM,
8K Boot ROM
+ DSP: 32K L1 I-Cache, 32K L1 D-Cache,
128K L2 Cache, 64K Boot ROM
B HD Coprocessors
+ Real-Time HD-HD Transcoding Up to 1080p
+ Multi-format (mf) HD to mf HD or mf SD
+ Up to 2x real time for HD-to-SD transcode
+ Real-time HD-HD transcoding for PVR
« Video Encode and Decode
+ HD 720p H.264 BP encode
+ HD 1080i/p H.264 HP@L4, decoding;
HD 1080i/p VC1/WMV9, decoding;
HD 1080i/p MPEG-2 MP@HL, decoding;
HD 1080i/p MPEG-4 ASP, decoding; DivX
+ Simultaneous SD H.264 BP 30 fps encode
and decode
B Peripheral Highlights
+ Video ports
+ Two 8-bit BT.656 or one 16-bit BT 1120 capture
+ Two 8-bit BT.656 or one 16-bit BT 1120 display
#Samples Dec. 07; TMS Qual 2Q08
#RTM December 3rd
Benefits
#Scalable video engine building on high-performance C64x+
media DSP, low-cost local controllers, and rich suite of
multi-format video accelerators
+$64 at 10kU

Applications

= Transcoding (HD-HD, HD-SD), HD-video conferencing,
HD-IP set-top boxes, video surveillance, video phones
and digital media adaptors

ARM

Subsystem Subsystem

Peripherals Connectivity System

DSP HD VICP 0

IPDE
C | LF

Stream /0

USB

C | |[Timel WM
20 [VLYNQ| ity X2 ||Ti x3
PHY MDIO

Program/Data Storage
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DaVinci Architecture

DaVinci Architecture

Dual MACs

'C6000 CPU Architecture

¢ 'C6000 Compiler excels at
Natural C

¢ While dual-MAC speeds
math intensive algorithms,
flexibility of 8 independent
functional units allows the
compiler to quickly perform
other types of processing

¢ All ‘C6000 instructions are
conditional allowing efficient
hardware pipelining

¢ 'C6000 CPU can dispatch up
to eight parallel instructions
each cycle

Challenge: Keeping 4800 MIPS CPU “Fed”

C64x+ CPU can:

read/write up to 9.6 GBytes per second data
read up to 19.2 GBytes per second program

but expensive

¢ Megabytes of fast internal memory is possible

& Better cost/performance using cache and DMA

Conclusion: Efficient data routing is crucial to
maximizing performance
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DaVinci Architecture

DM643x Internal Memory

¢ Level 1 Caches
L1 «+ Single-cycle access
Program T ] 2% + Always enabled
32K Bytes) 3
( « L2 accessed on miss
4 256 L2 + Configurable as cache
or addressable RAM
Program |,g or combination
CPU & Data |
¢ Level 2 Memory
~4 1+ 2x64 (128K Bytes) + Unified: Prog or Data
L1 + Configure L2 as cache
Data .—’I/ 256 or addressable RAM
(80K Bytes) or combination

C64x+ Improved Bandwidth

* Buses Internal to Megamodule

m‘ « Use of 256-bit buses

zse,I/ + Run at %2 CPU rate to save on power
. CPU/DMA concurrency in L1D

« 256-bits available every cycles
+  8Xx 32-bits

2 - ] « 128-bits maximum requested by CPU
+ 2 Xx 64-bit Paths to CPU
IDMA

L1P Controller

L2 Controller|zs
28

56
+ 128 bits left over for DMA
/L « Each 32-bit bank arbitrated independently

WVYS/8yded g1

ngﬁ' ¢ CPU/DMA concurrency in L2
+« CPU Access to L2 is infrequent over time
+ Insome chips, two distinct 128-bit pages

Megamodule
Interface

256

128 DMA Slave arbitrated separately

To 7RG =T Con:t;ﬁ‘l'lﬁ ¢  More DMA System Memory Connection
Egr\élA g Master Port]| 7 compared to C64x
Z req.) + 2 xbusses. Dedicated buses for each

+ Cache requests

+ DMA's into internal memory
« Upto 2 x width

+ 128 bits wide

32

L1D
Cache/SRAM
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DaVinci Architecture

DM643x EDMA 3.0

¢ EDMA 3.0
L1 + Performs data
Program ‘—’l' o transfers with external
@2 By S0 o
1 256 L2 + Capable of three
p concurrent transfers
éogr?m 128 (via TCO, TC1, TC2)
CPU ata = + EDMA User’s Guide
(SPRU987)
11 2x64 (128K Bytes)| 128
11 EDMA 3.0
pata |— 3 2 —=
128
(80K Bytes) TC|ITC[TC

Enhanced Direct Memory Access
Controller 3.0 (EDMA 3.0)

& Performs Data Transfers to offload DSP

¢ Transfer Controller (TC) Improvements over
DM644x
+ 3 Transfer Controllers (TCO, TC1, TC2)

« TCO: Short burst transfers with stringent deadlines (e.g.
audio data)

« TC1: High throughput bulk transfers
» TC2: PCl or miscellaneous transfers
+ Programmable Default Burst Size (DBS) for each TC
+ System Module register EDMATCCFG
+« Recommendation: Use default DBS

& Reference
+ EDMA User’s Guide (SPRU987)

» Device-Specific Data Manual for details on
EDMATCCEFG register
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DaVinci Architecture

DM643x Switched Central Resource

¢ SCR
L1 «+ Can route four
Program ‘—”l' S concurrent transfers
(32K Bytes) between CPU, EDMA,
device peripherals
4 256 L2 and memory
Program |, SCR | [VPFE]
CPU & Data |~ —| ~VPBE
[—>1
==
14 2xe4 (128K Bytes)| 1,g P} ] 128 EMIF
L1 1 EDMA 3.0
Data .—/I/ e 128 EMAC
(80K Bytes) [tc]{rc]tc]| | [_PCI ]
DM643x IDMA
¢ Internal DMA
L1 « Efficient programming
Program T 256 of CPU registers
(32K Bytes) + Offloads internal cache
o56 transfers from EDMA
256 - L2 « Capable of two
,s5| Program |, concurrent transfers
CPU ||IDMA |~ & Data |~
644+ 4 256 (128K Bytes)| 128
“T1 EDMA 3.0
pata |— 3 2 —=
128
(80K Bytes) TC|ITC[TC
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DaVinci Family Software

DaVinci Family Software

TMS320DM643x Software Overview

Application Layer

» User Interface

» Processing Thread (s)
» Network Services (NDK)
» Other

Operating System Layer (DSP BIOS and/or uC Linux)

Hardware Abstraction: EPSI and VISA

L1
Prog 1

2 [VPEE]
Prog | VPBE
e & Data SCR = 'DDR
NI EMIF
Serial

L1
Data [——— EDMA

It’s great to have this extensive memory and
data bus support, but is it difficult to program?

DaVinci 1-Day Workshop - Introduction
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DaVinci Family Software

Application Programming: EPSI API

L1 /
Prog 1
L2 VPEE
Prog | VPBE —
CEU & Data SCR_ [ /DDR] DDR
111 EMIF Mem
Serial
L1

Step 1: Read video data through VPFE, use EDMA to
route through SCR into external DDR memory

FVID_exchange(vpfeChan, bufp);

Application Programming: VISA API

L1
Prog 1
L2 VPEE

Prog | VPBE
CPU o

& Data SCR DDR DDR
b I (e | =
L1 T Y.
Data EDMA

s PCI

Step 2: Transfer raw video data from DDR memory into L1 Data
memory using EDMA. Compress in blocks directly from
L1 memory and store result back to DDR using EDMA.

VIDENC_process(videncChan, inbuf, outbuf, inarg, outarg);
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DaVinci Family Software

TMS320DM643x Software Overview

Module 1 Module 3

Module 2

Module 4

¢ We’ll examine these concepts in more detail
in the modules to come
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DM643x Family Development Tools

DM643x Family Development Tools

CCStudio v3.3 Merges All Platforms
Into One Easy-to-Use IDE

C6000™ C5000™ C2000™ OMAP™ DaVinci™

= Graphical User Interface

® Integrated Compiler,
Assembler and Linker

= DSP/BIOS operating system
(no per-unit license)

iy " Stop-based and Real-time
DAVINCI" B =4 JTAG Debugging

TEXAS INSTRUMENTS
" Open interface for Plug-ins
(Such as Mathworks’ Matlabt™)

Now supports C64x+™ and = Consistent IDE across 5 major
DaVinci processors DSP Platforms

£a4/CPU - C5 5w {Simulator) - Code Compeer - [hellac] 3 =101

A
D0 EX Yon i bow otk 0 ot ok EEHBKS e B a2l C- and ASM-callable functions

isimes:

Programming with DSP/BIOS

WER| BB o s e[ S RRhRER|¢
[rost BT EEECER RS EERD - - -
Pl ONEOBEEL GoF0P VOXEE gGUK Interactive configuration tool
Lk . L
el || [ Kernel-aware debug support
- Ix‘lfr]nr FILEIO J
=l Gar  Dileger(wrsize]; On-the-fly program analysis
= elze_t :‘:nd.S'.lze'.
a1 _'i'! nm.,{LE fpur o
0]+ t : A
Ea 4':' target application program
AT st 1 el f l ' '
[CAUHATED [ [ gl Fortip, pressFl in, cal i DSP/BIOS Kernel Interface

— -

|

HOST DEVELOPMENT COMPUTER JIAC TARGET TMS320 DSP HARDWARE
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DM643x Family Development Tools

SoC Analyzer

SoC Analyzer Windows Update in Real Time

Pl Lage U e istory

13 11 Db Come Deme

Collection Type Extraction Protocol

Sequencer logs BIOS logs over RTDX

v

Sits beside any IDE (Tl or 3rd party)

Can be easily made into an Eclipse
plug-in (ideal for CCE)

Primary use - visualizing SoC streaming
data, not post-mortem static data
analysis

It is not an IDE ... will not provide
basic debugging, project management
or editor

Based on TI's multi-client target
server

» Will support multiple host OS’s

v

v

Can be extended (by many — not just
TI) to provide multiple solutions

Primarily for high-level system tuning

Visualization Format

Time sequence of execution
profile

Application level profiling time
stamps

TCP/IP through ARM serial
port

Bar chart or Pareto rank

Link messages

MSGQ (SW)

Time stamped message sequence

DVDP Kit Features

Software

\saan o Imaging ), Speech -
- Videc \udio
\Codec \—)_99‘_‘_?‘_9_5__ —/\99‘??‘?5_ qdeﬁ}

» Demos
\DSP/Bloiﬂ pelinux ; gggscs
SoCrates Virtual Logix
System Linux
Analyzer

Quick Start
Guide(s)

Setup Guide

DVDP Software
> Codec Engine
» CSL/Drivers

l\\\/% /

§) a /

USB/Ethernet
Cables

AlV Files

ccs
> CSP :
> DSP/BIOS

SDI Software
» Flashburn
» EVM Docs
» Diagnostics
» PCI Host Driver

/

Power Supply
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DM643x Family Development Tools

DM6437 EVM Pinout

NAND Ethernet Emulation Codec

DAC A DDR2

Insert

Video Decoder

Connegctor JTA

Ethernet Phy Power
Socketed DM6437

Embedded Audio

DAVINCI
s )
TMS 328DMEAST Evie

Socket for SPI ROM

DM6437 EVM Block

5
E EEE ENET Ext JTAG =
2DAC 1234 DP i >a
Out [gpOO] LEDs =
ol 7] [ PHY JTAG Emulator
L &
E = a UARTs
DACC
- o
= NOR “-L 32 o
EMIF | Flash 8_ :8 SIAC oo
T ::::e N DM6437| | |t [ ron]
aenp|e OO B2 e O |
e R — =
Decod e
[omen o Eci = H
| | I PCI Connector I | E‘
Figure 1-1, Block Diagram DM6437 EVM
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Authorized Software Providers

Authorized Software Providers

e
DSP

Customized Support

TEXAS INSTRIMAENTS

it

ys a!ﬂﬁj

Credentials
« Software expertise

« Engineering services

« Application expertise

.+ Proven customer satisfaction

’....

technology based and other TI DSPs

Additional integration and customization services available
ASPs can act as single point of support for multiple algorithms
Experienced in video applications

L 2R 2R 2R 2

Authorized Software Providers

Companles selected to resell and fully support xDAIS algos on DaVinci

Selected based on support and service capability, customer track record

from

HNEDINWORKS

\ In Development

§ Future MPEG4

T1 Digital Media Software Roadmap

A
Algorithm -Ae0
. (\\J\d Full HD
Production 0\0\\0 Video Suite
_ Re>
\ Sampling \’\0 Video Codecs Next Generation

Video Transcoders

\Next Generation DSP

H.264 HP

d '\, Video Codecs

720p HD D
DM6446 Next Generation
> Video Codecs
= 72"?)PEHGDZD Video Codecs N
D Video Transcoders
x DM6446 ¢
) oy e Vext Generation DSP. 1 264 Hp
o DM644x™ \
E = H264 MP D v1.0
Video Cod Phase 1) = WMV9/VC1 Dec v1.0
8 e sz + JPEG E/D V1.0 oo
= MPEG-2 D Vv1.0 = Phase 1 Codecs, v1.1 ‘:\0\'\ \I\de
* H.264 BP E/D V1.0 5o\
DM642 = H.264 MP D v1.0
* MPEG- 4 SP E/D SD
*MPEG?2 E/D, H.263 E/D * H.263 V. . .
jivoo JrecEp Audio Codecs (tase 2) Audio/Voice
goeintetacing 644x™ Voice Codecs
+0SD Lib AAC HE E/D Audio Codecs
AC3D RUTC00 Voice Codecs Niﬁtﬁ:r&e;gggn
i WMA E/D ext Generation DSP
Aumogﬁgiﬁiﬁhﬁe D'\, « Phase 1 update, v1.1 \ G.xxx E/D \
« AACLCD €5000 Audio e
= MP3 D = MP3 E/D
- MCLeED N goomen
2005 2Q06 3Q06 4Q06 1HO7 2H07
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Analog and Logic Companion Chips

Analog and Logic Companion Chips

Analog and Logic Companion Chips

http://www. ti.com/davincihpa

LEDs

2

rCc . [ 1 GPIOS

Lp— -
x
g o
g E p
8
™ ! -
(g Image In; Analog Video
= 3

Smart Media/xD Card

EMIF Compact Flash Card

|

ATA Card

Complete Power Management
Solution for DaVinci™ Processors

Control IH—W

Functions
s (D63
beriace —TETCI

~~baizigfl

#-..;" Actual Size
#.{i- TEXAS INSTRUMENTS 5 mm x § mm
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Analog and Logic Companion Chips

Yeo TpSE5023

WM T
WM DT
WM O

WIM_L D

LIMN_EATT
PWRFAIL_SHS
LOWEAT_SWS

HOT_REZET
TRESFWRON

DEFLIEN
DEFLD
LD:_EN
WY
VEACKLIP
VR
FWREAIL

DR _EN
DD EN
DEFDLICE
DEFDLDCZ
DEFDLDCT

DCRCT_FH RESPWRON

nar_ i

LoC2

L

W3
L3

AGHET
AGNLT
PGEHDT

PGEHDE
PENDE

DaVinci
TMS320DME449%

SCLE
a0AT

CVDDDS
USE_YDDPILDO

a2
Voo Damain
APLLREFY
whDa_1ey

ovmae

CVOORZ

VODA_TPEY

WUSE_WDDPE 1AV
MDD Domain
FLIVDOE

DOR VDD

AN

UEE_VDDAIFI a3y
(R IREE] Damain
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For More Information

For More Information

For More on the C6000 Architecture

DaVinci Webpage
http://www.ti.com/davinci

Technical Documents (User’s Guides, etc.)
http://focus.ti.com/dsp/docs/dspsupporttechdocs.tsp?sectionld=3&tabld=409&familyld=44

DaVinci Software —benchmarks, pricing, availability
http://www.ti.com/digitalmediasoftware

C6000 Optimization Workshop
http://focus.ti.com/docs/training/catalog/events/event.jhtml?sku=4DW102260

DSP/BIOS OS Design Workshop
http://[focus.ti.com/docs/training/catalog/events/event.jhtml?sku=4DW102090
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Lab

Lab

In the lab exercise for the first module, we will compile, load and execute the primary example
application that is packaged with the DM6437 Digital Video Development Platform (DVDP).
This example demonstrates many features available with this system, including networking, audio
and video processing, and capture and display of audio and video data. The example is built upon
an extensible framework that may be adapted to user applications, and is provided fully in source
code with the exception of the evaluation codec libraries, the Networking Development Kit
(NDK) libraries and the DSP/BIOS operating system libraries utilized.

DVDP Demo

C CS A Temas Instruments: BME437 Dema, Host Application vi). 48

B JEVI DMBAZTepu D - Chaxx - Code Composer Studio - [app_main.c]
{p Fie Eot vew Promct Debug GEL Qoton Profe Toos DSP/BIOS Window e =2 X

AW ¢ & S A RRRRY S G
[T —— +|[Ceces 7] P | . &
Hle 00=HEHEA

sl e e
i #

<stdlib

b
& (stnn_q.r.;
=
& ] it} R [+
[[DRZ =etup [ DDRZ @ 16Z Miz | w/ 32-bit bus... [Done] =l Presselonte Lo wrie
INEMIF setup ( B-bit bus )... [Done] =)
[ET5 7 o6 ovens/ —a llel |
!. HALTED (D Fie: C:pkespSA37 fralfab }_demopoures l = E —
< [Cem
= Host PC pd
) LL

The example demo consists of two applications — a server application which executes on the
DVDP and a client application which executes on the host PC. The server application is built
(compiled and linked) inside of the Code Composer Studio development system. Though Code
Composer Studio itself executes on the host PC, this tool builds code which executes on the
DM6437 DVDP and can be used to load this code onto the board and execute it.

The client application is a host-side application that runs on the PC host computer. This
application is written in Javascript, which is in interpreted language, meaning that it does not
have to be compiled before it is executed. This has the advantage that development and
debugging are simpler and faster. The host-side client is used to control the operation of the demo
running on the DM6437 DVDP.
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Lab

Block-based Video Channels

File File
Write Read
1 2
Video Video
Video ™ Encoder Decoder Video
Input Output

1. Video Recorder
2. Video Playback
3. Video loopthru with encode/decode
4. Video loopthru

The client-side (i.e. executing on the DM6437 DVEVM) application is written within a modular
framework that provides a simple mechanism for re-routing data between processing blocks. Four
pre-defined routing structures allow for the four modes of record, playback, loopthru and loopthru
with encode/decode. Selections on the host-side application are communicated via the host-to-
board ethernet connection and implemented within this framework as shown on the above
diagram.
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Build/Load/Run the DVDP Application

1.

Start Code Composer Studio (If not already open)
You should have a shortcut icon on the Windows desktop

DM&437 EVM
CCStudio v3.3

Connect the DVDP board emulation
Debug->Connect

or Alt-C

For Convenience, Configure Code Composer Studio to always Connect at Startup
Option—>Customize...

In the “Debug Properties” tab, under the “Target Connection Actions”, check the checkbox
for “Connect to the target at startup”

Now you won’t need to do Debug—>Connect every time you start CCS.

Load the dm6437_demo.pjt project into CCS
Project>Open...

Navigate to C:\dm6437_1day\labl_demo_1_30
select dm6437_demo.pjt

Open the app_main.c file

You can expand the “Source” folder within the project view window and double click on the
file name to open it.

Search within app_main.c for the string “APP_GLOBAL _data.ndk”
Edit>Find... (or Ctrl-F)

Confirm the following networking properties

status = APP_SYSTEM_ configSet(
intcpy(APP_GLOBAL data.ndk.priority
strcpy(APP_GLOBAL_data.ndk. ipAddrMethod
strcpy(APP_GLOBAL_data.ndk.staticlpAddr
strcpy(APP_GLOBAL data.ndk.subnetMask
strcpy(APP_GLOBAL_ data.ndk.gateway "0.0.0.0" );
strcpy(APP_GLOBAL_data.ndk.domainName "tidsp.demo.net™ );
strcpy(APP_GLOBAL data.ndk.dnsServer , '192.168.1.39" );
strcpy(APP_GLOBAL_ data.ndk.dnsName , 'tidsp');
intcpy(APP_GLOBAL data.ndk.ipDiscoveryPort, 44000 );

13 );

"static" );
'"192.168.1.41" );
'"'255.255.255.0" );

Note: This settings are correct for the workshop installation. For home use, this is where you
can modify the application to match your network configuration. If connecting the board into
a router, change the ipAddrMethod property to “dynamic” (IP address, gateway, domain,
DNS values set in this configuration will be ignored and the system will use the values
provided by the router via the DHCP protocol.)
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8. Reset the dm6437 CPU on the DVDP board
Debug—>Reset CPU (or Ctrl-R)

Note: It is a good idea to always reset the CPU before loading any new program

9. Build the project
Project->Rebuild All

10. Load the binary executable onto the DVDP board
File->Load Program... (Or Ctrl-L)
Navigate to C:\dm6437_1day\labl_demo_1 30\Debug
select dm6437_demo.out

11. For convenience, set CCS to automatically load .out files after build
Option—>Customize...

In the “Program/Project/C10” tab, under the “Program Load”, check the checkbox for “Load
Program After Build”

Now you won’t need to do File=>Load Program... every time you rebuild your project.

12. Execute application on the DVDP
Debug—>Run (or F5 key)

13. Start DVD Player or other Video Input source

You should see a Loopthru of the video into your display. You will not hear audio at this
time.
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Run the Host Application

PC-Side Demo Application
[0 7excos nstruments: pMAI DR HE=&|

Target CPU Load

i brput

.......

14. Using Windows Explorer, navigate to the hostapp folder of Lab 1
C:\dm6437_1day\labl demo\hostapp

15. Execute the “run.bat” batch file

Note: This script contains a full-path reference to
C:\dvsdk_1 01 _00_15\xdc_2 95 02\xs.exe This is correct for the in-class environment, but
may need to be modified to match the installation path on other systems.

You may simply click on the file, or right-click and select Open. It should not be necessary to
debug this script, but for future reference, scripts may be run from the command line by
opening a command window:

start>Run... and type in “cmd” or “command”

Within a command window, you can use standard DOS commands, i.e.
dir = list contents of current directory
cd <directory> = change to the specified directory

<filename> = execute the given file, such as run.bat

16. Connect to DVDP via the Host Application

The run.bat script should bring up the Host Application window. In the top left corner of this
window is the connection section. Enter the IP address of the DVDP into the IP Address
window. The static IP address of the board will be whatever you specified for the
ndk.staticlpAddr field in step 7 of the “Build/Load/Run the DVDP Application” section.
(The instructions recommend 192.168.1.41) If this was configured for dynamic operation,
then you may either consult the standard output window in CCS, where the application will
print the board’s IP address, or you may use the discover feature of the host application.

After you have entered the IP Address, press the Connect button. If you are properly
connected, the Status field should diplay “CONNECTED, PLAYING” and you should see a
welcome message in the Target Messages window.
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17.

18.

19.

20.
21.

22.

Press the Stop button to halt the current demo
The stop button is located at the bottom of the Host Application window.

Enable audio in the demo
Within the config section of the window is a checkbox for “Enable Audio”

Select one of the four modes of the demo

Within the Mode section of the window are four modes. If you have selected either the
“Decode from File” or “Encode to File” modes of operation, specify the appropriate Audio
and Video files. These files are stored on the harddrive of the Host PC and are transmitted
from the DVDP board to the Host PC via Ethernet.

Press the Play button

Observe Statistics for Operation

In the top left corner of the Host Application window is the Target Application section. Select
various tabs for given information as well as the real-time Target CPU load and Network
Usage.

When you finish, press stop and repeat steps 19-21 for other modes of operation.
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Introduction

/O and Drivers
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DILBERT: © Scott Adams/Dist. By United Feature Syndlcate, Inc.

Data input and output is an integral aspect of any embedded system. Drivers provide a simple,
modular interface for application developers to access the various peripherals of a given
processor, and by compartmentalizing the work of data I/O into drivers, system developers can
increase the portability and reliability of their embedded products.

And fortunately, both the efficient Linux and DSP/BIOS based drivers available for the DM6437
will never be scapegoats for system performance, as in our cartoon above!
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TMS320DM643x Software Overview

Available Peripheral Drivers

v v
v v
v v
v %
v %
v v
v v
v (In AIC33 Audio)
v v
(Low Level) v
(NDK) (Network Stack)
(Low Level) x
X X

X

X
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The Video Processing Sub System

The Video Processing Sub System

Video Processing Sub System (VPSS)

Video Processing Sub System (VPSS)
| ccoc |{Previewer[+{ Resizer | | 0sp |+ VENC D
Digital
H3A Display
| TETIT]

Video Processing Sub System (VPSS) is comprised of two blocks:

Front End (VPFE)

+ CCD Controller (CCDC)
+ Statistics Engine (H3A)

+ Previewer

+ Resizer
(se

TEXAS INSTRUMENTS
TECHNOLOGY

Back End (VPBE)
+ On-screen Display (OSD)
» Video Encoding (VENC)

VPFE : Resizer, Previewer, H3A

—>| CCDC |-—|Previewer|-—| Resizer |

H3A

H3A

« Statistical engine for calculating image
properties
¢ Histogram:
« Histogram data collection (in RGB color
space)
« ARM + DSP can access these statistics
& Automatic Focus Control
& Automatic White Balance Correction
& Automatic Exposure Compensation

Previewer

¢ Bayer RGB to YChCr 4:2:2 color space conversion
& Programmable noise filter

& Offloads processing effort

Resizer

& 4xto 1/4x Resizing N/256 Zoom step
¢ Linear and Bi-Cubic Resize Algorithms
¢ Automatic Video Rescale

+ Offloads processing effort
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The Video Processing Sub System

Video Processing Sub-System (VPSS)

¢ Provides Interface to Input/Output Video
¢ Video Processing Front End (VPFE)
+ CCD Controller (CCDC)
+ Previewer
+ Resizer
+ Histogram/H3A
¢ Video Processing Back End (VPBE)
+ On Screen Display (OSD)
+ Video Encoder (VENC)
+ DAC
¢ VPSS Improvements Over DM644x
+« Some OSD register bits have changed location
+ Included some bug fixes from DM644x
+ New features (TBD). Stay tuned
¢ VPSS Reference Guides
+ VPSS FE (SPRU977)
+ VPSS BE (SPRU952)

CCDC Interface Diagrams

YUV
CCD Sensor DM6437 CCDC
CCD[15:0] > CCD[15:0]
Pixel CLK »{ PCLK
H Sync »! HD
V Sync > \D
Field ID » C_FIELD
BT.656
TVP5146 DM6437 CCDC
Y[9:2] > CCD[7:0]
Pixel CLK »! PCLK
@i

TEXAS INSTRUMENTS
TECHNOLOGY
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The Video Processing Sub System

Video In

Tl TVP5146M2 video decoder sources the 27MHz video clock

1 S-video jack

1 Composite jack

i when CI_EMA_ENABLERN is pulled
i high on the daughtercard

a

8-bit YCbCr
to YI[7:0]

Switch disconnects decoder
from VPFE interface to allows
use of VPFE on header DC_P1

VPFE : Resizer, Previewer, H3A

On Screen Display

& Four video/graphics planes

¢ Alpha Blending

& Automatic Focus Control

& Automatic White Balance Correction
& Automatic Exposure Compensation

0SD VENC =

'

Video Encoder
¢ Analog output:
+ Four 54Mhz 10-bit DACS

+  Composite NTSC/PAL video

« S-Video

«  Component (YPbPr) or RGB
< Digital Ouputs:

« Max Pixel clock rate: 75 Mhz (720p and

1080i use 74.25 Mhz)
+ 8/16 bit YUV
+ upto 24-bit RGB
« BT.656 for NTSC/PAL
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The Video Processing Sub System

VPBE On-Screen Display (OSD)

Video Window 0

video PSP_VPBE VID_0 YCbCr 4:2:2
Video Window 1
video PSP_VPBE VID_1 YCbCr 4:2:2

L PSP VPBE_OSD 0  RGB16

| PSP VPBE_OSD 1  RGB16

B

¢ Two video windows for picture-in-picture
¢ Two OSD windows or one OSD window + attribute window
¢ OSD attribute mode provides pixel-level alpha blending

Set-Top Box OSD Usage

VideoO - Background \ Videol — Overlay (e.g. PIP)
]
P
m Law & Order;
"Kid Pro Quo* OSDO —
Wed Apr 30, 10:00 pm - 11:00 pm on-screen menu
Several people are suspects when the head of /
admissions for a private schopl is killed.
10:23 pm
Not Recording
( Wed ) 10:00 pm 10:30 pm 11:00 pm 11:30 pm Oospl1-
w8 70  The World's Worst Driver...  The Practice (Crime) alpha-blending/
- Fx pix-by-pix OSD
73 { World Poker Tour (Travel) Top Ten Predators Up Clo... attribute

TRAV

e} 3 Law & Order (Crime) | Channel 3Ne.. TheT.. % e Cursor -
WKYC as selection

4 Action News at Te.,. Sp.. Seinfeld() ~ Seinfeld() -,
B wuse @ @
Ted 9 /.. Extreme Makeover (M... New--hanne.. Myntiin...
L4 WEWS
\ )

SP

TEXAS INSTRUMENTS
TECHNOLOGY
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The Video Processing Sub System

VENC : Display Options

RlYe eI AENE NTSC / PAL Output Options
’7 DAC_IOUT_A + Composite 1DAC
— \IXI  DAC_IOUT_B + S-Video 2 DACs
Al DAC IOUT C « Component 3 DACs
DAC_IOUT D —= _ SDTV ° e SIDAES
= - can mix these, up to 4 DACs
DM6437 VENC THS8200 Video
Encoder
YOUT[7:0] Y[9:2]
74.5 COUT[7:0] ch:2] vy HD
== VPBECLK  jsynC HS_IN Analog
MHz u i Component
VSYNC = VS_IN Pr _
Video
LCD_FIELD === FID
VCLK CLKIN
Note: DM6446 VENC can produce 8/16 bit YCbCr or 24-bit RGB digital output

Video Output

1 unpopulated

RCA jack | @
3 populated /-: L
RCA jacks — —|

1 S-Video

output jack \ﬁ

o

4 OPA361s with Integrated Op-amps
and Reconstruction Filters

OPA3G1 3.6pF
2264 220

- Mf—e—N +

= soon 12, 5pF

+ Sallen-Key filter
i with 9MHz cutoff

» Supports Composite, S-Video, and Component SDTV Output
* S-Video muxed with RCA jacks on DACs B and C
« Digital VPBE provided on header DC_P1
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The FVID Video Driver (DSP/BIOS)

The FVID Video Driver (DSP/BIOS)

IOM Queue Structure

incoming (empty) queue
s oge o m .
C
= £ ! I o L
- 35 L I = 5
T O I a
o un . (&)
v c outgoing (full) queue = u
[ ! o C
_'C_3 ; ! i o ;
> O T B
! i
b . ]

& Application takes ownership of a full video buffer from
the outgoing driver queue using FVID_dequeue

# After using the buffer, application returns ownership of
the buffer to the driver using FVID_queue

& FVID_exchange is simultaneous queue and dequeue

FVID Buffer Passing

FVID_queue(hStream, bufp);

status

status FVID_dequeue(hStream, &bufp);

¢ FVID_queue() returns an empty buffer to the driver to be filled (input driver)
or passes a full buffer to the driver to be displayed (output driver)

& FVID_dequeue() aquires a full buffer from the driver (input driver) or
acquires an empty buffer from the driver for app to fill (output driver).

« if no buffers are already available in the stream, this call can block until
a buffer is made available from the driver

« pBufis passed by reference for FVID_dequeue to modify with the
address of the return buffer

status = FVID_exchange(hStream, &bufp);
// is equivalent to:

// status = FVID_queue(hStream, bufp);

// status |= FVID_dequeue(hStream, &bufp);
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The FVID Video Driver (DSP/BIOS)

FVID APIs
\

gioChan = FVID_create(name, mode, status, optArgs, attrs) C
opens a new video channel and returns its handle through gioChan

status = FVID_alloc(gioChan, &bufp)
driver allocates a video buffer and returns a pointer through bufp

status = FVID_control(gioChan, cmd, args)
passes various control comands to driver through cmd, with argument list args

status = FVID_queue(gioChan, bufp)
grants driver access to bufp buffer by placing on incoming queue

status = FVID_dequeue(gioChan, &bufp)
grants application access to bufp-returned buffer by removing from outgoing queue

status = FVID_exchange(gioChan, &bufp)
performs simultaneous queue (bufp initial value) and dequeue (bufp return value)

status = FVID_free(gioChan, bufp)
frees the driver-allocated buffer pointed to by bufp (see FVID_alloc)

status = FVID_delete(giochan)
frees the video chanel specified by the giochan handle (see FVID_create)

FBVID Driver Example for VPFE

Void taskFunction(...)
{
viHandle = FVID_create(...); = Create and
FVID_control(viHandle, ...); Initialize chan
FVID_alloc(viHandle, &bufPtr);
FVID_queue(viHandle, bufPtr); <———e Double-buffered
FVID_alloc(viHandle, &bufPtr); system
while (‘condition’){
FVID_exchange(viHandle, &bufPtr);<—e Exchange old
buf for new
I* Process */ <+ Actually do
} something w/
input video buf
FVID_free(viHandle, bufPtr);
FVID_dequeue(viHandle, bufPtr); «<——e Free both
FVID_free(viHandle, bufPtr); buffers
FVID_delete(viHandle); ¢ Delete chan
}
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The FVID Video Driver (DSP/BIOS)

Video Window 0
video
Video Window 1

video

=

Video Port Back End Features

PSP_VPBE_VID 0  YChCr4:2:2

PSP_VPBE_VID_1 YCbCr 4:2:2
PSP_VPBE OSD_0 RGB16

PSP VPBE_OSD 1  RGB16

Each video/osd plane in the VPBE is opened spearately and then
referenced by its own unique handle:

&vpbeParams, NULL);

vpbeParams.id = PSP_VPBE_VID_O;

voOHandle = FVID_create(*“/VPBEO”, I0M_INOUT, NULL,
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The Audio Serial Port

The Audio Serial Port

AIC33 Codec .
,
I‘C TI _AIC33 Codec
scL Control SCL
spp e op
I’C Format ControlRegisters :
/H X *
[ Digital | -
McASP or McB§f (Control) || ¢ i Sy
AXR[0] DX i i) r - &
AXRIT] R Asmraf DIN e I
ACLKR f 25 Formal h
ACLKX CLKX BOLK o
AFSR FSR - WCLK DAC LINE OUT
AFSX FSX = |—<]-p HP OUT

4+—— Optical and Coax
S/PDIF output available
when AIC33 not in use

1
1
| via FET switch for daughtercard i
I use of MCASP and McBSP1 I

Multichannel Audio Serial
Port (MCASP)

¢ Serial Audio Interface

« Transmit and receive audio to/from a
DAC/ADC
+ Time-Division Multiplexed (TDM) stream
+ Inter-Integrated Sound (I2S) stream

« Transmit in Sony/Philips Digital Interface
(S/PDIF) format

+ Up to 4 data pins to allow parallel
audio streams

¢ Multiplexed with McBSP
¢ MCASP Reference Guide (SPRU980)
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The Audio Serial Port

Device Address RMW | Device Function
TVP5146M2 0x5D RW uso Video Decoder
PCF 8574A 0x38 RW u10 User Input
PCF 8574A 0x39 RW ut1 User LEDs
* PCF 8574A 0x3A RW U13 PLL, User IO
g PCF8574A 0x3B RW U4 User IO
S TLV320AIC33 0x1B RW u43 CODEC
Q
i 24WC256 0x50 RW U2 12C EEPROM
O
&
* uin
DD A

<] 12C Addr.
B

12c <&
+——Interrupt <=
| to GP[4]/PWM1 DSP I/0

| pin with daughtercard E
i

o

-
P - SB23KZEB |2
! v o

PCFBE74APWRGS

Inter-Integrated Circuit (1°C)

¢ Serial Control Interface
+ Used to configure Audio/Video Codecs
+« Communicate with other I2C devices

¢ Features
+ Frequency up to 400kHz (I2C Fast Mode)
+ Master/Slave

¢ Improvements over DM644x I2C

+ Slew-Rate Limited Open-Drain Output Buffer
meet Philips 12C Specification Revision 2.1
rise/fall time requirements

+ Note: Like DM644x, no fail-safe 1/0 buffer
¢ [|2C Reference Guide (SPRU991)
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The Audio Serial Port

CAN & UART

CAN Female DB-9 UART Male DB-9

CAN Population SLEFEREE R )| 7| MAX3221
options for Common s RS-232 Transceiver

Mode Choke and
ESD Suppressor TI SN65HVD235 CAN Transceiver

CAN and UART Transceivers can be disconnected from the DSP via a FET |
switch to allow TIMER1 and UART1 use, respectively on a daughtercard |}

Universal Asynchronous
Receiver/Transmiter
(UART)

& Miscellaneous Serial Interface
+ Microcontroller Interface

« Can be configured to interface through MSP430
(low cost 16-bit microprocessor):

« Keypad Interface
+ IR Control Interface
+ Switches/LEDs
« Smart Card Interface
« Debug terminal
« Miscellaneous Control Interfaces
¢ Features (same as DM644x)
+ Follows the TL 16C550 Industry standard
¢ Pins: Hardware Flow Control on UARTO only
¢ UART User’s Guide (SPRU997)
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The Audio Serial Port

High-End Controller Area
Network Controller
(HECC)

¢ Serial Interface for Automotive
+ Interface through CAN Transceiver to

CAN Bus

¢ Features

+ Compliant with the Controller Area
Network (CAN) Protocol, Version 2.0B

+ Bus speed up to 1 Mbps
+ Receive/Transmit

¢ HECC User’s Guide (SPRU981)

Cose

TEXAS INSTRUMENTS
TECHNOLOGY

Serial Interfaces

- Full duplex - Compatible with | - Master Mode - Maximum Baud
B T ;’Tllps Spec Rev ozper:tlon | Ra;e of 128k:z
' - 2 chip-selects | - 16 Byte FIFO on
aﬁ::rl%?‘r\(ljeﬁefg - Fast Mode up to | for interfacing to | Transmit and
' | 400kHz multiple slave Receive

o - 7-bitand 10-bit | SP! devices - DMAFIFO
- 25 Mbps TX/RX Addressing -3 or 4 wire Synchronization
'Slsa%ﬁ’gorts = - Master & Slave | nterface - Configurable

Functionality -33 Mbps TX/RX | Byte Size / Parity

| Stop Bits

AIC33 Audio Codec | [2C Master Mode | TBD 115,200bps / 8-hit
8 — 48 kHz Sample char/no parity /
Rates 1 stop bit
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The SIO Audio Driver (DSP/BIOS)

The SIO Audio Driver (DSP/BIOS)

IOM Queue Structure

incoming (empty) queue
l'___________________l
5 5 H = e .
c
= = ! | o i
- 35 L I = 5
S T o
o un . (&)
O c outgoing (full) queue_ = v
[ ! o C
e = ' : Q =
> O © o
! ]
I }

+ Identical queueing mechanism to FVID driver

& Application takes ownership of a full video buffer from
the outgoing driver queue using SIO_reclaim

& After using the buffer, application returns ownership of
the buffer to the driver using SIO_issue

SIO Buffer Passing

status = SI10_issue(stream, bufp, nmadus, arg);

nmadus = SIO_reclaim(stream, &bufp, &arg);

& SIO_issue returns an empty buffer to the driver to be filled (input driver) or
passes a full buffer to the driver to be displayed (output driver)

¢ SIO_reclaim aquires a full buffer from the driver (input driver) or acquires an
empty buffer from the driver for app to fill (output driver).

« if no buffers are already available in the stream, this call can block until
a buffer is made available from the driver

« pBufis passed by reference for SIO_reclaim to modify with the address
of the return buffer

nmadusOut = SIO_put(stream, &bufp, nmadusin);
// is equivalent to:

// S10_issue(stream, bufp, nmadusin);

// nmadusOut = SIO_reclaim(stream, &bufp);
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The SIO Audio Driver (DSP/BIOS)

FVID APIs

stream = SI10_create(nhame, mode, bufsize, attrs) C
opens a new audio channel and returns its handle through stream

nmadus = SIO_staticbuf(stream, &bufp)
driver allocates an audio buffer and returns a pointer through bufp, size is nmadus

status = SI0_ctri(stream, cmd, arg)
passes various control comands to driver through cmd, with argument arg

status = SI0_issue(stream, bufp, nmadus, arg)
grants driver access to bufp buffer by placing on incoming queue

nmadus = SI0_reclaim(stream, &bufp, &arg)
grants application access to bufp-returned buffer by removing from outgoing queue

nmadus = SI10_put(stream, &bufp, nmadus)
performs simultaneous issue (bufp initial value) and reclaim (bufp return value)

status = SI0_idle(stream)
idle a stream — should be called before SIO_delete

status = SI10_delete(stream)
frees the audio chanel specified by the stream handle (see SIO_create)

SIO Audio Driver Example

Void taskFunction(...)
{
aiHandle = SIO_create(...); <———+ Create and
SIO_ctrl(aiHandle, ...); Initialize chan
size = SIO_staticbuf(aiHandle, &bufPtr);
SIO_issue(aiHandle, bufPtr, size, NULL);<—& Double-buffered
SIO_staticbuf(aiHandle, &bufPtr); system
while (‘condition’){
SIO_put(aiHandle, &bufPtr); «——& Exchange old
buf for new
[* Process */ <+ Actually do
} something w/
input video buf
SIO_reclaim(aiHandle, &bufPtr, NULL);
SIO_idle(aiHandle); <~——¢ Reclaimand idle
SIO_delete(aiHandle); 4 Delete chan
}
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VirtualLogix Linux Drivers

VirtualLogix Linux Drivers

User Access to Kernel Space

User Space
main(){
funcl();
~ func2();
Imypath/myfile
‘mounted’ to
root file system | filesystem

[/devindal | [/devidsp|  [/devivideoO]

Kernel Space I

Block — random Character - sequential

Using Character Device Drivers
Simple drivers use the same format as files:

+ soundFd = open(“/dev/dsp”, O _RDWR);

+ read ( soundFd, aMyBuf, len ); len always in # of bytes
+ write( soundrFd, aMyBuf, len );

+ close( soundFd );

Additionally, drivers use I/O control (ioctl) commands to
set driver characteristics

+ 1octl( soundFd, SNDCTL_DSP_SETFMT, &format);
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SIO Audio Driver Example

Void taskFunction(...)
{
soundFd = open(“/dev/dsp”, O_RDWR); =<+— Open audio device
while (‘condition’){
read(soundFd, aMyBuf, length); «<—e Input audio buffer
[* Process */ ¢ Filter audio buffer
write(soundFd, aMyBuf, length); <—re Output filtered
audio
}
close(soundFd); 4 Close audio device
}

v4l2 Driver Queue Structure

incoming (empty) queue
l'___________________l
5 5 ﬁ H =
c
= £ ! I o L
- 35 L I = 5
T O I a
o w : ©
O c outgoing (full) queue_ = v
S ] ! o C
— ; : i o ;
> O T B
! ]
I }

¢ Application takes ownership of a full video buffer from the
outgoing driver queue using the VIDIOC_DQBUF ioctl

& After using the buffer, application returns ownership of the
buffer to the driver by using VIDIOC_QBUF ioctl to place it on
the incoming queue
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FVID Buffer Passing

1octl(v412Fd, VIDIOC_DQBUF, &bufp);

status

status 1octl(v412Fd, VIDIOC _QBUF, &bufp);

¢ VIDIOC_QBUF returns an empty buffer to the driver to be filled (input driver)
or passes a full buffer to the driver to be displayed (output driver)

¢ VIDIOC_DQBUF aquires a full buffer from the driver (input driver) or
acquires an empty buffer from the driver for app to fill (output driver).

+ if no buffers are already available in the stream, this call can block until
a buffer is made available from the driver

« pBufis passed by reference for FVID_dequeue to modify with the
address of the return buffer

Note: the v412 driver does not support an
“exchange” function as do SIO and FVID

V412 video Driver Example

Void taskFunction(...)

{
vidinFd = open(“/dev/video0”, O_RDWR); < Open video device

while (‘condition’){
ioctl(vidinFd, VIDIOC_DQBUF, &buf); +e Acquire video buf

[* Process */ Use video buffer

L 2

ioctl(vidinFd, VIDIOC_QBUF, &buf); <t Return video buffer
to driver

}

close(vidinFd); Free video device

2
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For More Information

More info on DSP/BIOS Drivers

DM6437 DSP/BIOS PSP User’s Manual
Included in PSP DOC folder in SDK installation

DSP/BIOS Driver Developer’s Guide
Literature Number: SPRU616

http://focus.ti.com/lit/ug/spru616/spru616.pdf

User’s Guides for each Peripheral:
Such as VPFE user’s guide, Literature # SPRU977
http://focus.ti.com/lit/ug/spru977/spru977.pdf
See product folder at:
http://focus.ti.com/docs/prod/folders/print/tms320dm6437.html

TMS320C6000 DSP/BIOS 5.31 API Reference Guide
section 2.9 GIO module, section 2.26 SIO module
Literature Number: spru403n.pdf
http://focus.ti.com/lit/ug/spru403n/spru403n.pdf

More info on VirtualLogix Linux Drivers

VirtualLogix™ VLX for Digital Multimedia v2.0 User Guide
Chapter 9: Using Linux Kernel Modules
http://www.virtuallogix.com/index.php?id=166

Video for linux two (v412) video driver online documentation
http://www.thedirks.org/v412/

Open sound system (OSS) audio driver online documentation
http://www.opensound.com/oss.html

Linux driver details:
Linux Device Drivers, Third Edition, O’Reilly, Feb 2005
ISBN: 0-596-00590-3
http://www.oreilly.com/catalog/linuxdrive3/
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Lab 2a (DSP/BIOS version)

Important: Labs 2-4 of this workshop are presented in two versions, one utilizing DSP/BIOS
only (Lab 2a) for the operating system, and one utilizing VirtualLogix Linux and
DSP/BIOS executing concurrently (Lab 2b). You will only have time to complete
one version, so please choose the lab version appropriate for your system.

Lab2a osd bios Software Diagram

FVID VIN driver
(“/VPFEQ")

Composite
video in =

echo (BIOS TSK)

FVID OSD driver
(“/VPBEQ")

. FVID ATTR driver
Composite “ "
video out 4 (/VPBEQ")

FVID VOUT driver
(“/VPBEQ”)

BIOS Operating System

In this lab, you will explore the On-Screen Display (OSD) capabilities of the Video Port Back
End (VPBE) of the Video Port Sub-system (VPSS). The provided video loopback application not
only captures and displays live video but overlays a custom-drawn picture (picture.c) using the
DM6437 Video Port Back End On-Screen Display hardware.
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Create a Custom Banner
1. Start Code Composer Studio using the Desktop Shorrtcut

Note: you will need to make sure that the DM6437 dsk is connected (via USB emulation
cable) and powered on.

2. Load the video_preview.pjt project from the lab2a_osd_bios directory
Project->open...
select video_preview.pjt from the C:\dm6437_1day\lab2_osd folder.

3. Open the picture.omp file

Expand the Documents folder in the project file tree and double click on the picture.bmp file.
Note that the file will be opened with the Windows default editor for the file type. In your lab
setup, this may be the windows picture viewer. If so, you can right click on the banner image
and select “Edit” or “Open With...” from the drop down menu.

To change the editor that the file is opened with, you will need to change the default “Open
with...” option for the .omp file type in Windows. In XP this can be done by locating the file
in Windows Explorer, right clicking, selecting “Open with...” and checking the “Always use
this program to open this file type” option.

4. Redraw the picture.bmp to create a custom banner

5. Save and close picture.omp
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Build/Load/Run the project

6.

10.

Examine the custom build options for picture.omp

Code Composer Studio natively knows how to build C, assembly and RTSC (more on this
later) source files into a project. However, CCS does not have a native build option for
bitmap source files, so we have to create a custom build option for this file.

To view the custom build option for the file, right click on picture.omp and select “File
Specific Options...”

Notice that the “Use custom build step” box has been checked, and below this checkbox,
there are boxes to specify the build command, the output file and a clean command. Note that
the specified output (picture.c) appears under the “Generated Files” of the project source tree
and that we do not need to specify custom build options for this file because CCS natively
knows how to build C source.

Examination of the Build Command

%XDC_INSTALL_DIR%\tconf.exe bmptoc.js picture.bomp picture.c gBanner

Shows that we are using a javascript script (bmptoc.js) to convert the bitmap image toa C
source file. Examination of picture.c shows that this script converts the bitmapped image into
a global array named gBanner and specifies the width and height of the array with global
variables gBannerWidth and gBannerHeight. The command-line options specified to this
script are picture.omp (the input file), picture.c (the output file) and gBanner (the name of the
global array that is generated.)

javascript was chosen to implement this utility because it is portable across most platforms
and because a Javascript Virtual Machine (JVM) and various file manipulation libraries are
included with the XDC tool installation (more on the XDC tool in module 3). The source
code for bmptoc.js is included in this project for your reference.

Connect the DM6437 dsk
Debug—>Connect (Alt-C)

Build the project
Project->Rebuild All

(You will get a number of warnings/remarks in the build output, but should get no build
errors.)

Load the video_preview.out executable onto the DM6437 DSK
File->Load Program... (Ctrl-L)

select video_preview.out from the Debug subfolder of the C:\dm6437_1day\lab2_osd
directory.

Run the executable
Debug—~>Run (F5)
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CCS Debugging Tools
11. Halt execution on the dsk
Debug->Halt (Shift-F5)

12. Set breakpoint within main video loop

Open video_preview.c, locate the echo() function and scroll until you find the following code
section:

/* loop forever performing video capture and display */
while ('done && status == 0) {

/* grab a fresh video input frame */
FVID_exchange(hGioVpfeCcdc, &frameBuffPtr);

/* display the video frame */
FVID_exchange(hGioVpbeVid0, &frameBuffPtr);

}

This section of code acquires a pointer to an input buffer of video data using FVID_exchange
with the hGioVpfeCcdc (Video port front end) device and then immediately passes this video
data to the hGioVpbeVid0 (Video port back end) display device. It is located with a while
loop that will continue looping until either the “done” or “status” variables are modified.

Set a breakpoint on either of the FVID_exchange calls by selecting the appropriate line in the
file, right clicking, and selecting “Toggle software breakpoint”

13. Run to the breakpoint that you set in step 12

The variables that we will use to specify the memory region we would like to graph are local
variables. Therefore, if the program is not halted within the function that references these
variables, they are out of scope and will not be recognized by the graphing utility.

Debug—>Run
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14. View the frame buffer structure pointed to by frameBuffPtr

Highlight the frameBuffPtr variable in the CCS editor, right click and select “Add to watch
window” Expand the structure by clicking the plus sign to the left of the variable name.

Mame | Valuz | Type | Radix |
-1 & frameBuffPir <B0151B60 FVID_Frame * hex
+ @ e Flemeant {3} Q1 IF_Flem hee
-5y frame {3 union anorymous_union | hex
+ 5 iFm {.} FVID_IFrame hex
+%§ pFm {.} FVID_PFrame hex
+%§ riFm {.} FVID_Rawl|Frame hex
+ % mFm {.} FVID_RawPFrame hex
B fremebufferPtr [ 0a80151C00 | Fir
¥ tmeStamp 1176 Uint32 unsig...
@ pitch 1440 Uirt32 unsig....
@ limes 400 Uirt32 unsig...
@ bpp FVID_BPF_EITS16 (16} FVID_bitsPerPixel dec
i FrameFomat -196063R003 FYID_ColorFormat dec
+ = userParams (OF4FOFOF Pir hex
+ = misc B 170F1FOF Pir hex
=
& Wach Locsls % Walch 1
Ln 122, Col 46

The frame buffer structure holds all of the information for a ¢

iven video frame that is used by

the driver, including the number of lines, the bits per pixel and the pitch (width times bits per

pixel).
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15. View display video buffer
View->Graph->Image...

Fill in the graph properties as follows

= Graph Property Dialog

Graph Title

Color Space

Interleaved Data Sources
Start Addrezs - B Source
Start Addrezs - G Source
Start Address - B Source
Lines Per Dizplay

Pixelz Per Line

Byte Packing to Fill 32 Bitz
Indesx Increment

Imaae Qrigin

Uniform Quantization to 256 Colors
Status Bar Dizplay

Curzor Mode

Image

Graphical Dizplay

RGE

Mo

frameBuftPtr-» frame.frameB ufferPtr+1
frameBuftPtr-» frame.frameB ufferPtr+1
frameBuftPtr-> frame. frameB ufferPt+1
frameBuftPtr-> inesz
frameBuffPtr-»pitch * 8 / frameBulfPti-bpp
Mo

2

Top Left

Mo

On

Mo Cursar

] | Eancel| Help |

Note: We are filling in the graph to display the image in black and white format (this is why
the same pointer is used for red, green and blue channels in the graph.) Although the data
that we are graphing is actually a color image, it is stored in UYVY packed (interleaved) data
format, where Y is luminance or intensity, which is the only data that we are using in the
graph. U and V values represent red and blue chrominance (color) deviations from green.

The CCS graphing utility does have a YUV mode; however it does not currently support
interleaved UYVY data (it expects the data to be planar with separate buffers for Y, U and
V). This black and white graph using the RGB graphing utility is a work around. However,
being able to view the image buffers directly from the device is a very useful debugging tool

(even if only viewed in black and white), so we wanted to show you this technique.
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16. View OSD video buffer
View->Graph—->Image...

Fill in the graph properties as follows

2 Graph Property Dialog

Color Space

Interleaved Data Sources
Start Address

Lires Per Dizplay

Fixels Per Line

Byte Packing to Fill 32 Bits
Bitz Per Pizel

Image RGE Order

Image Ongin

| niform (uantization to 256 Colors
Statusz Bar Display

Cursor Mode

[raphical Dizplay

RGE

e

gicpbed sdWin-» frame. frameB ufferPtr+1
aic'pbelzdwin-»lines

ginpbed sdwin-» pitch = 8/ gioY pbe0 sdWwin-> bpp
Mo

16 [E Bits for Green]

RGE

Top Left

Mo

On

Mo Curzor

ak | Qancel| Help |

Note: the name of the frame buffer pointer, gioVpbeOsdWin, contains “Osd” standing for
on-screen display. Be sure not to type in a zero instead of capitol O or you will get an

“Identifier not found” error when you hit OK.
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17. View alpha blending buffer
View->Graph->Image...

Fill in the graph properties as follows

= Graph Property Dialog

Graphical Digplay

Lines Per Dizplay
Fizels Per Line

Calor Space RGE
Intereaved Data Sources Tes
Start Address giotpheditttein-: frame. frameBufferPt+1

giot phedittrin-: inesz
giophedttidin-: pitch

Bute Packing to Fill 32 Bits Tes

Image Row 4-Bute Aligned Mo

Bits Per Pixel 8 [256 Color Palette]
Falette Option Gray Scale of 266 Calors
Image Origin Top Left

Statuz Bar Dizplay On

Cursor Mode Ma Curzaor

OF. | Eance|| Help ‘

The graph will appear narrow due to the fact that we are concatenating pairs of 4-bit attribute
pixels into an 8-bit value to be displayed. The shading you see is almost completely
determined by the most significant pixel in the pair. For debugging purposes, this should be
sufficient as the zones represented in the attribute window typically do not vary on a pixel-
by-pixel basis.

You may notice a band of zero values along the right side of the graph. This is due to the fact
that the attribute window must be extended beyond the 720 pixel display width in order to
have a line width that is divisible by 32 bytes. This is a requirement of the driver and is
purposefully done in order to make sure that each image line does not extend beyond the L1D
cache line (which could cause unpredictable behaviour when caching is used.)
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Lab 2b (VirtualLogix Linux version)

Important: Labs 2-4 of this workshop are presented in two versions, one utilizing DSP/BIOS
only (Lab 2a) for the operating system, and one utilizing VirtualLogix Linux and
DSP/BIOS executing concurrently (Lab 2b). You will only have time to complete
one version, so please choose the lab version appropriate for your system.

Lab2b_osd_linux Software Diagram

FVID VIN driver
(“/devival™)

Composite
video in =

echo (pthread)

FVID ATTR driver

Composite ” r
video out 4 (“/devifbi2")

FVID OSD driver
(“/dev/fb/1")

FVID VOUT driver
(“/dev/fb/3")

Virtuallogix Linux Operating System

In this lab, you will explore the On-Screen Display (OSD) capabilities of the Video Port Back
End (VPBE) of the Video Port Sub-system (VPSS). The provided video loopback application not

only captures and displays live video but overlays a custom-drawn picture (picture.c) using the
DM6437 Video Port Back End On-Screen Display hardware.

This lab is run completely within a VMware virtual machine. This tool allows us to run a Linux
host operating system on our lab PC’s, even though the PC’s are actually running a Windows
operating system. Currently VirtualLogix Linux build tools require a Linux host. Furthermore,
debugging Linux applications is typically simpler from a Linux hosted environment.

DM6437 1-day - I/0O and Drivers



Lab 2b (VirtualLogix Linux version)

Start the Linux Virtual Machine
1. Start the Red Hat Enterprise Linux 4 Virtual Machine

There is a shortcut on your desktop that will bring up the Virtual Machine information page

5."'1

Red Hat
Enterprize
Linux 4. vmx

Select “Start this virtual machine” from the information page

[P Start this virtual machine

2. Log in with user permissions

There are two Linux accounts set up:

user: user
password: useruser
user: root
password: rootpw

3. Open a terminal window

right-click in the desktop and select “Open Terminal”

Configure Ethernet Port in Virtual Machine

4. Within the terminal you opened in step 3, use “su” command to switch to root
permission

# su

enter “rootpw” as the password when asked

5. Use the following procedure to configure the ethernet port with static IP address
192.168.1.40

# /sbin/ifconfig ethO down
# /sbin/ifconfig ethO 192.168.1.40
# /sbin/service nfs restart

6. Exit out of root permission (to user permission)
# exit
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Create a Custom Banner

We will introduce some basic linux terminal commands in this section. For those who are not
familiar with linux terminal commands, you may wish to refer to the on-line manual for more
information. To access the on-line manual page of a given command, use the “man” command
followed by the name of the command you want more information on. For instance, to get more
information on the “cd” command, type:

# man cd
and to get more information on the man command itself, type
# man man
(Note, here we are using the hash symbol ‘#’ to represent the command prompt. It does not need
to by typed in.)
7. Change to the workshop/lab2_osd directory
Use the linux “cd” (change directory command)
# cd workshop/lab2_osd

note: If the terminal gives you an error that there is no such directory, you have probably
logged in as root instead of user. Log out by hitting Ctrl-Alt-Ins (not Ctrl-Alt-Del 1) and
selecting “Log Out” then log in with the user account as shown above

8. list the contents of the lab2_osd directory

Use the linux “Is” command

9. change to the osdfiles directory and list the contents

you will see the following files

bmptoc.js a javascript script which converts a bitmap image to a global array ina C
source file.
makefile a gnu makefile which provides instructions to build the picture.c C

source file from picture.omp

pic.mak referenced by makefile (This is done so that makefile can invoke pic.mak
with the path variables as set in setpaths.sh)

picture.omp  the bitmap file of a banner that will be placed in the video output of the
final application using the DM6437 hardware osd capability

picture.c picture.omp translated into a data array for inclusion in the application

note: setpaths.sh is a shell script that is contained two directory levels up from the current
directory. This shell script is used to set environment variables that define the location of
various tools and libraries that are used in the lab exercises. No absolute paths are referenced
in the lab exercises, but instead, these environment variables are used. When you install the
lab exercises on your own host machine, you will need only to modify the paths set in
setpaths.sh to specify the locations of your installed packages.
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10. Use the gimp application to modify picture.omp
# gimp picture.bmp

When you are finished modifying the banner, you can save your new image with File->save
or Ctrl-S

11. Change directory back to the top level of lab2_osd
#cd ..

Rebuild and Install the Application

12. Change to the app directory and run gnu make specifying the “install” target
# cd app
# make install

Boot Linux on the DM6437 DVEVM

13. Start Tera Term Pro from the Windows Desktop

L=
Tera Term Pro

18. Start Code Composer Studio using the Windows Desktop Shortcut

2]
CCStudio v3.3

Note: you will need to make sure that the DM6437 dsk is connected (via USB emulation
cable) and powered on.

We will use Code Composer Studio to load the linux kernel onto the DVEVM and boot.
Note, however, that the filesystem which Linux will use is a network share using the Network
File Share (nfs) filesystem, and the shared path is located within the Linux environment of
the virtual machine. When you ran the “make install” command in the previous section, the
make utility not only rebuilt the lab2_av.out applction, but copied it to this shared directory
so that it will be available to execute from the DVEVM board

19. Connect the DM6437 dsk
Debug—>Connect (Alt-C)
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20.

14.

15.
16.

17.

18.

Load the kernel, vix and bootloader onto the DM6437 DSK
File=>Load Program... (Ctrl-L)
Navigate to C:\dm6437_1day\lab2b_osd_linux

Load each of the three executables in the following order:

nkern.out Virtuallogix vix virtualizer
vmlinux.out Linux kernel
bootloader.out Bootloader program

note: the order is important because bootloader.out needs to be loaded last so that the correct
entry point is set. The order of nkern and vmlinux don’t actually matter.

Run the program

Debug—~>Run (F5)

You should see feedback as the Linux kernel boots, ending with a login prompt:
192.168.1.41 login:

If the kernel feedback gives an error before reaching the login prompt, ask your instructor for
help.

Login as root user, no password
Change to the /opt/workshop directory
# cd /opt/workshop

Load the audio and video driver modules with the loadmodules.sh script
# _/loadmodules.sh

note: if you would like to see the contents of this script, type:

# cat loadmodules.sh

Execute the lab2_av.out application
# ./lab2_av.out
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Software design is a fluid process. A powerful and flexible framework is a great enabler in any
software development, especially when requirements change suddenly or quick-turn prototyping
is required. The Codec Engine is a production framework provided by Texas Instruments for use
with the DaVinci series of processors. This framework provides a stable but agile base for you to
build your applications upon.

All you need now is to decide what you want the Codec Engine to do for you!

Workshop Title - The Codec Engine 3-1



Module Topics

Module Topics

L LR oo L= Toll = o To 1 o TSSOSO 3-1
T LU T=TN o ot PSSR 3-2
The CodeC ENGINe FrameWOIK ..........ciiiiiiiiiieiitenieest ettt sttt b sr et 3-7
VISA AP ..ottt ettt s et b s bt R bt R R bRt R e bRt b et R et e a Rt n et et be et e enen 3-9
COodeC ENGINE DELAIIS .......oiveiciiiiecseee bbb bbb b 3-11
Configuring the COUBC ENQINE........oiui ittt ettt b bbb eneenbenbe b 3-15
RESOUICE AITOCALION ...t bbbt e e bbb e bt et e e e et e e sbe e 3-18
FOr MOFe INTOFMATTON ...t ettt bbb bbb et s e e et e b e e 3-21
Lah 38 (DSP/BIOS VEFSION) .....ccviiieiviiieeieiesiesiestesteseste e esaestesaesbestestestessseseessebestestestessesseeseenseseessensenns 3-23

Examine, Build and Test the APPlICAtION........c.ccvcieiiii i 3-24
INSEIt JPEG ENCOUEN ..ottt ettt ettt b ettt eb e et sb et st e be b 3-27
Modify JPEG ENCOUEr PArAMELEIS .......cveierieiieiteeteeeeiesteste e steste e e e e sae e ste e neeseeaeaeseessennesnens 3-28
=T o TR (T DGRV Z=T 3 o ) S 3-29
Start the LinUX ViIrtual IMACHINE ..........ooiiieie et sre e 3-30
Configure Ethernet Port in Virtual Machine...........cccocviiiiiiiiie e 3-30
Build the Linux-side APPIICALION .....c.ciiiiiiiiieee s 3-31
Boot Linux on the DIMB437 DVEVM ......couciiiiiiiiiiiiiese et nsens 3-31
RUN and VIEW APPIICALION ..ottt ettt et b et e bbb 3-33
INSEIT JPEG ENCOUET ...ttt ettt e bbbttt e bbbt b e bt et e e e e b e b 3-33
(Optional) Modify JPEG ENCOTEr Parameters........c.ccvciveieiieireieseseeeeiesiestese e steseeeesnesresresnesreens 3-34

Workshop Title - The Codec Engine



Module Topics

Currently Available Codecs for DM643x:

Video
» H.263 (profile 0) D1 encode
« H.263 (profile 0) D1 decode
+ H.264 BP D1 encode
+ H.264 BP D1 decode
+ H.264 MP@level 3 D1 Decode
+ MPEG2 MP@level 3 D1 Decode
« MPEG4 SP D1 Decode
« MPEG4 SP D1 Encode
VCL1 (includes MP) Decode

+ G711

+ G.726

+ G.729AB
« G.7231
« G.7222

DM6437 Video Capabilities

STANDALONE CODECS Resolution D(SD';Aléjigl%a@tl%%(l)R/lM;Z
FOR CONSUMER VIDEO

H.263 Profile 0 Decode CIF (<2 Mbps) 60 MHz
MPEG2 MP/ML Decode D1 (<10 Mbps) 200 MHz
MPEG4 SP Decode D1 (<10 Mbps) 193 MHz
H.264 BP Decode D1 (<4 Mbps) 300 MHz
H.264 MP/L3 Decode D1 (<4 Mbps) 470 MHz
MPEG4 SP Encode, High Speed D1 (3-5 Mbps) 312 MHz
MPEG4 SP Encode, High Quality D1 (2.5-5 Mbps) 340 MHz
H.264 BP Encode, High Speed D1 (2.5-4 Mbps) 530 MHz
H.264 BP Encode, High Quality D1 (2.5-4 Mbps) 562 MHz
ADDITIONAL FEATURES

Capture/Display 1 Video In/1 Video Out

Network Connectivity 10/100 EMAC

Peripheral Integration MUN?C? /glg ’ égg EDD,RAZC @

1. All performance data is for 30fps YUV 4:2:0 unless otherwise noted. Note that the
performance will vary depending on efficiency of code and data stream used.

. Resolution Information: D1 (720x480) / CIF (352x288)

. SP = Simple Profile / MP= Main Profile / BP=Base Profile

. Image quality and bit rate were not held constant across these measurements. Current
numbers are based off of independent testing for consumer types of applications. These
numbers describe our current status and are undergoing further optimizations.

HwN
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DM6437

Audio Capabilities

DSP Utilization in Peak

STANDALONE CODECS Sample Rate MHz (DM6437 @ 600MHz)
AUDIO

MP3 L1 Decode 44.1 kHz (384 kbps) 15 MHz
MP3 L2 Decode 44.1 kHz (192 kbps) 17 MHz
MP3 L3 Decode 44.1 kHz (128 kbps) 24 MHz
AC3 Decode 48 kHz (640 kbps) 45 MHz
eAAC+ LC Decode 48 kHz (128 kbps) 27 MHz
eAAC+ LTP Decode 44.1 kHz (128 kbps) 42 MHz
eAAC+ HEHQ Decode 44.1 kHz (64 kbps) 73 MHz
eAAC+ PS Decode 44.1 kHz (320 kbps) 71 MHz
AAC LC Decode 48 kHz (128 kbps) 20 MHz
AAC LC Encode 44.1 kHz (128 kbps) 38 MHz
SPEECH

G.711 Decode 8 kHz (64 kbps) 0.22 MHz
G.711 Encode 8 kHz (64 kbps) 0.25 MHz

DM6446 Video Decoder Performance

Video Decoders

H.264 baseline
H.264 main
MPEG-4
H.263

WMV9 -MP
WMV9 -AP
MPEG2

300-350*
350-450
80-100
80-100
200-260
300-360
100-150

MHz Req'd for D1 30fps

30 fps max resolution w/ VICP

X . Normal mode Turbo Mode
Bit Rate Quality

<5 Mbps D1 D1
<5 Mbps VGA D1
< 5 Mbps
<5 Mbps
<5 Mbps

SXGA
SXGA
720p/24
<5 Mbps D1
<15 Mbps

*All benchmarks are preliminary and subject to change.
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DM6446 Video Encoder Performance

MHz Req'd for D1 30fps

Video Encoders with VICP w/o VICP D1 Bit Rate Quality Normal Turbo

H.264 baseline 410* 760* 2 -5 Mbps 15db D1 (W/IMCOP) D1(w/IMCOP)
MPEG-4 (high-video quality) 250 350 3-8 Mbps 1.0db D1 720p/24
MPEG-4 (high-frame rate) 180 300 4-10 Mbps 1.0db 720p/24 SXGA/24
H.263 250 350 3-8 Mbps 1.0db D1 720p/24
WMV9 350 500 3 - 8 Mbps 1.0db D1 D1
MPEG2 350 500 3 - 8 Mbps 1.0db D1 D1

Still Mpix/sec Normal (450MHz) Mpix/sec Turbo (600MHz) Max video w/ VICP (size/fps)
Capture/Playback with VICP with VICP Normal

Tl Image Pipe* 185-19.1 8.7 24.7-255 116 VGA/60 720p/24
JPEG enc (standalone) 45 (est.) 321 60 (est.) 42.9 SXGA/30 1080i/24
JPEG dec (standalone) TBD 30-45 TBD 40-60 720p/30 SXGA/30

*All benchmarks are preliminary and subject to change.

DM6446 Audio Codec Performance

MHz Req'd MHz Req'd

i Comments
Audio codecs (average) (peak) Bit Rate

AAC-LC/Dec 9 11 128 Kbps 44.1 KHz — 128 Kbps (stereo)
AAC/+Dec (low power) 15 21 128 Kbps 44.1 KHz — 128 Kbps (stereo)
AAC/+Dec (high quality) 22 32 128 Kbps 44.1 KHz — 128 Kbps (stereo)
WMAQ9 dec (HBR) 320 Kbps 48 KHz — 320 Kbps (stereo)
WMAQ dec (MBR) Y 32 Kbps 44 KHz — 32 Kbps (stereo)

WMAQ dec (LBR) 20 Kbps 22 KHz - 20 Kbps (stereo)

WMAB8 enc (32kbps) 32 Kbps 44 KHz - 32 Kbps (stereo)
WMAB8 enc (48kbps) 48 Kbps 44 KHz — 48 Kbps (stereo)
WMAB8 enc (80kbps) 80 Kbps 44 KHz — 80 Kbps (stereo)
MP3 dec 128 Kbps
G.711 ! ! 64 Kbps
G.728 16 Kbps

*All benchmarks are preliminary and subject to change.
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acT ‘TEkFps
MEpw jacsr TR
14-19ch ifps -8k [QSF tkFps [Mifps
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DaVinci Provides HD Video
Performance and Lowers BOM Cost

Video
Processing Subsystem
0) a

Integrated MJCP

» MPEG-4 SP HD
(720p) encode
or decode, 30 fps

Preview

ARM
Subsystem

o = Resizer

ARM

processor 216 MHz On-Screen | Video | 10b DAC
- CPU Display Enc
» JPEG 50 Million (0sp) | (VENC)
pixels per
second Application
Specific DSP Equivalent
DSP Equivalent Peripherals VPSS Feature  Performance
MJCP Feature  Performance DM355 Preview engine | Up to 90 MHz
_’;APPEEGG-“ and Up to 400 MHz Resizer Up to 60 MHz
Total Up to 400 MHz — ES———
Total Up to 240 MHz

VPSS + MJCP provides equivalent of 640 MHz DSP processing
power, ARM available for OEM product differentiation

‘ Built in video encoder and DAC saves ~ $2 on overall BOM cost |

Technology for Innovators® i TEXAs INSTRUMENTS
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The Codec Engine Framework

The Codec Engine Framework

The codec engine provides a robust, consistent interface for:

1. Dynamically creating and deleting algorithms
2. Accessing and controlling algorithm instances

CﬂdecEf"s“m’v‘ih>:J Algo
: [

VIDENC_create() xDM handshaking
(VISA interface) (iAlg, iDMA interfaces)

Algorithm Access

The Codec Engine provides standardized process and control
calls for using algorithms it creates. This:

1. Allows algorithms of the same class to be easily
exchanged without any modification to application code

i) | cwmeroe |
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Algorithm Access

2. Allows the same application code to be used across a
variety of platforms without modification

DM355 .
= (=
DM643x _
(DSP only) Algorithm
DM644x .
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VISA API

Engine Functions
CERuntime_init

Engine_open
Engine_close
Class (VISA) Functions

VIDENC_create
VIDENC_control
VIDENC_process

Engine

VIDENC_delete

DSP/BIOS

Conceptual View — Codec Engine

The Application Interfaces to the
Codec Engine Framework Through:

# Process: invokes the algorithm
calls the algorithms processing function
passing descriptors for in and out buffers

+ Control: used to change algo settings
algorithm developers can provide user
controllable parameters

# Delete: deletes an instance of an algo
opposite of “create”, this deletes the
memory set aside for a specific instance
of an algorithm

SP
VISA — Four SPL Functions
Linux/ARM Programmer & Complexities of Signal Processing Layer
create() (SPL) are abstracted into four functions:
control( _cCreate _delete
(; _process _control
process( -
delete( VISA « Create: creates an instance of an algo
‘ API that is, it malloc’s the required memory
¥ and initializes the algorithm
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VISA — SPL Interface

V'S

Linux/ARM Programmer & Complexities of Signal Processing Layer

create() Video (SPL) are abstracted into four functions:
control( Imaging _create _delete

_process _control
VIDENC_process() Speech
; & VISA =4 processing domains :
delete Audio ) . .
( ‘ Video Imaging Speech Audio
& Separate API set for encode and decode

thus, a total of 8 API classes:
VIDENC IMGENC SPHENC AUDENC
VIDDEC IMGDEC SPHDEC AUDDEC

v

| |
Complexity

Reducing dozens of APIto 4

Filling out the Master Thread ...

SIO Audio Encoding Example

Void taskFunction(...)
{
aiHandle = SIO_create(...);
size = SIO_staticbuf(aiHandle, &bufPtr);
SIO_issue(aiHandle, bufPtr, size, NULL);
SIO_staticbuf(aiHandle, &bufPtr);
CERuntime_init(); 0 < Initialize CE
myCE = Engine_open(...); environment, open
myAE = AUDENC _create(myCE,...); Engine creat'e P
while (‘condition’){ codec
SIO_put(aiHandle, &bufPtr); )
AUDENC_process(myAE, ...);=——¢ Process audio
[* Store result somewhere */ buffer and store
}
AUDENC_delete(myAE); <% Return codec and
Engine_close(myCE); engine resources
SIO_reclaim(aiHandle, &bufPtr, NULL); to system
SIO_idle(aiHandle);
SIO_delete(aiHandle);
}
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Codec Engine Details

Codec Engine Framework Benefits

< Multiple algorithm channels (instances)
¢ Dynamic (run-time) algorithm instantiation

¢ Plug-and-play for algorithms of the same class (inheritance)
+ Sharing of memory and DMA channel resources

+ Algorithm interoperability with any CE-based Framework

& Same API, no new learning curve for DM644x users

< Provided by TI!

Many of these benefits are a direct result of the
object-oriented structure of the codec engine

aaaaaaa

Comparison of Functions and Algorithms
Why do | have to create an MPEG Algorithm?

In summary: an algorithm maintains internally
managed resources which must be created
an initialized for each algorithm instance.
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xDM / C++ Comparison: Object

« xDAIS and xDM provide a C++-like object implemented in C.
« Because C does not support classes, structs are used.

« Because structs do not support methods, function pointers
are used.

XDM / C++ Comparison: Methods

Constructor
algo::algo(algo_params params)
VIDENC_create(VIDENC_ params params)

Destructor
algo::~algo()
VIDENC _delete()

Generic Methods

algo: :myMethodl(method_params params)
VIDENC_process(..)

VIDENC_control(..)

Note: with xDM, the CE Framework allocates resources on
algorithm request, as opposed to a C++ constructor,
which allocates its own resources.
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Algorithm Creation

Traditionally algorithms have simply used
resources without being granted them
by a central source

Benefits of Central Resource Manager:

1. Avoid resource conflict during system
integration

2. Facilitates resource sharing (i.e. scratch
memory or DMA) between algorithms

3. Conistent error handling when dynamic
allocations have insufficient resources

VISA Create and Delete

Create and Delete

+ The application creates a local (or
m remote) video encoder instance
through the VIDENC_create API

+ The VIDENC create or
VIDENC_delete function passes
the request to the Engine, which

«+ determines if the requested
codec is local via the codec
table

- » And, if the codec is local,
Engine grants or frees resources such
as memory and DMA channels
to/from the algorithm

DSP/BIOS 3
» These resources ultimately
come from the Linux O/S,
which the Engine accesses via
its O/S Abstraction Layer
SP

TEXAS INSTRUMENTS
TECHNOLOGY
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VISA Control and Process

Control and Process

« The application accesses a codec
instance through VIDENC_control
and VIDENC_process API

« The VIDENC_control and
VIDENC_process functions call
corresponding control or process
function from the Codec.

« Control and process calls made
via a function pointer in the
VIDENC_object

Engine + Reason for this extra mechanism
will become more clear when we
DSP/BIOS study remote codecs
SP

TEXAS INSTRUMENTS
TECHNOLOGY
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Configuring the Codec Engine

Configuring the Codec Engine

Framework Configuration

(@ Fies ¢ Codec Engine, DSKT2 and
(2 GEL fies DMANS are configured in
- 23 Projects app.cfg, similarly to DM6446
= i dm643x_demo.pit (D server builds.
[:I Dependent Projects
=123 Documents ¢ xdcpaths.dat provides
e repository search paths for all
%:k”*” packages used in app.cfg
EE . ' ¢ app.tcfis a standard BIOS tconf
e i file. It's name and path must
+1 [ Generated Fies match the .cfg file used in the
+1-(23 Include prOJeCt
+1-[Z7 Libraries
+1-(Z3 Source
< >

e

Codec Engine Configuration

Engine Configuration File
app.cfg
var osal = xdc.useModule(‘ti.sdo.ce.osal.Global’);

y osal.runtimeEnv = osalGlobal.BIOS;

.

Enaine AP M || var audEncl =
VISA API e Engin xdc.useModule(‘codecs.audencl.AUDENCL’);
codec % var audEnc2 =
XDM 1 xDM 1| table xdc.useModule(‘codecs.audenc2. AUDENC2);
Codec | Codec
OSAL
e var Engine = xdc.useModule(‘ti.sdo.ce.Engine’);

var myEng = Engine.create(“myEngine”, [

DSP/BIOS DSP Link {name: “myEnc1”, mod: audEncl, local: true},

{name: “myEnc2”, mod: audEnc2, local: true},

1)
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Codec Engine Configuration

Engine Configuration File
app.cfg
var osal = xdc.useModule(‘ti.sdo.ce.osal.Global’);

osal.runtimeEnv = osalGlobal.LINUX:

Engine -1 | var audEncl =
/QE;:: xdc.useModule(‘codecs.audenc1. AUDENCY’);

codec| SPI var audEnc2 =
table xdc.useModule(‘codecs.audenc2. AUDENC2’);

var Engine = xdc.useModule(‘ti.sdo.ce.Engine’);

Engine

var myEng = Engine.create(“myEngine”, [

Linux DSP Link {name: “myEnc1”, mod: audEnc1, local: true},

{name: “myEnc2”, mod: audEnc2, local: true},

1)

Codec Engine Configuration

Engine Configuration File
app-cfg
var osal = xdc.useModule(‘ti.sdo.ce.osal.Global’);

osal.runtimeEnv = osalGlobal.LINUX;

var audEncl =
xdc.useModule(‘codecs.audencl. AUDENCL");

var audEnc2 =
table xdc.useModule(‘codecs.audenc2. AUDENC?’);

\var Engine = xdc.useModule('ti.sdo.ce.Engine’);
var myEng = Engine.create(“myEngine”, [
Linux DSP Link {name: “myEncl”, mod: audEncl, local: true},

{name: “myEnc2”, mod: audEnc2, local: true},

1

Engine
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Engine and Algorithm Names

Engine configuration file

var myEng = Engine.create(“myEngine”, [
{name: “myEnc1”, mod: audEncl, local: true},
{name: “myEnc2”, mod: audEnc?, local: true},

1)

Application Source File (app.c)
CERuntime_init();

myCE = Engine_open(“myEngine”, myCEAttrs);
myAE = AUDENC_create(myCE, “myEnc1”, params);

AUDENC_control(myAE, ...);
AUDENC_process(myAE, ...);

VIDENC_delete(myAE);
Engine_close(myCE);
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Resource Allocation

Codec Creation (Instantiation)

P =

VIDENC_create() xDAIS handshaking
(VISA interface) (iAlg, iDMA interfaces)

1. Codec Engine gathers algorithm resource
requirements from algorithm via iAlg and iDMA
interfaces

2. Codec Engine secures resources from resource pool

3. Codec Engine grants resources to Algo viaiAlg and
iDMA interfaces

The xDAIS Transaction

Params memTab

=

Algorithm -
« Knows memory requirements

» Requests appropriate resources -

from Application

Application (CE Framework)
* Manages memory requests -

- size
* Determines what memories are i
{ : ! alignment
available to which algorithms - 9
and when space
T attrs
- addressl
Physical Memory “space”:

External (slow, plentiful, less cost)
Internal (fast, limited, higher cost)
SARAM, DARAM

SP

TEXAS INSTRUMENTS
TECHNOLOGY
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Create Phase

algAlloc
alglnit

Execute Phase

algDeactivate
(algMoved)

Delete Phase

algFree

SP

TEXAS INSTRUMENTS
TECHNOLOGY

Codec Creation: xDAIS

xDM inherits xDAIS instantiation functions

algNumAlloc Create phase functions use a
handshaking mechanism to request
memory from the framework

algActivate algActivate and algDeactivate are
used for scratch memory sharing
between algorithms.

algNumAlloc When an algorithm instance is
deleted, memory resources are
returned to the framework.

Initialization Phase (config-time)

SRAM:

0x8000_0000- DSKT2
0x8010_0000

IRAM:

0x0000_0000-
0x0004_0000

DMAN3
PaRam:
#'s 63-127 ===
tcc: m’ ©]0)
#'s 32-63 000
Physical DMA AAA
channels AAA

DSKT and DMANS

One last detail: The engine allocates resources to the codecs.
How does it know which resources are available?

Usage Phase (run-time)

Algl:
DSKT2 ~ B 20k sram,
B sk IRAM
Alg2:
H7 B 10K SrRAM,
- [ 10K IRAM
DMAN3 Algl:
- 2 PaRam,
0= Jﬂ. 1 tcc
1 DMA ch
000 Alg2
{MI 2 PaRam
AA @ 1 tcc
A A 1 DVMA ch
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DSKT2 Setup in app.cfg

var DSKT2 = xdc.useModule('ti.sdo.fc.dskt2.DSKT2');
DSKT2.DARAMO ="L1DSRAM";

—n Algorithms request memory from the
DERUZDINRARE = LIDER framework using IALG/XDAIS
DSKT2.DARAM2 ="L1DSRAM"; identifiers (DARAMO, DARAML, etc).

—n . Those identifiers are tied to system
DSKT2.SARAMO  ="L1DSRAM®; memory heaps here. The heap names
DSKT2.SARAM1 ="L1DSRAM"; mhust match healps thfat are cre?lted in

—n the BIOS textual configuration file
DSKT2.SARAM2 ="L1DSRAM"; (server.tcf)

DSKT2.ESDATA ="DDRALGHEAP"; - f - - I I
— The size for each scratch memory poo

DSKTZ.IPROG =" 1DSRAM®; is set in an array. The first element is

DSKT2.EPROG ="DDRALGHEAP"; for scratch memory pool id =0, the

DSKT2.DSKT2_HEAP = "DDR": second for pool id=1, etc.

DSKT2.DARAM_SCRATCH_SIZES = [ 65536, 1024, 0,0,0,0,0, /*...*/ 0 ];
DSKT2.SARAM_SCRATCH_SIZES = [ 65536, 1024, 0,0,0,0,0, /* ... */ 0 ];

if( this.prog.build.profile == "debug")
DSKT2.debug = true;

DMANS3 Setup in app.cfg

var DMAN3 = xdc.useModule('ti.sdo.fc.dman3.DMAN3");

/I set dman to use all external memory because video codecs take it all
/I note: scratch size of 60000 worked for mpeg and then leave internal

DMANS3.idma3Internal = false;
DMANS3.heapinternal = "L1DSRAM"; In addition to physical DMA
DMANS3.heapExternal = "DDR": resources, module needs

some memory for storing
DMAN3.PaRamBaselndex = 78; PaRam shadows and other
) channel configuration states.
DMAN3.numPaRamEntries = 48;
—y PaRam granted to the
DMAN3.numQdmaChannels = 8; DMAN3 module by base

4—|_ i
DMAN3.gdmaChannels = [0,1,2,3,4,5,6,7]; 4—|_ index and number

DMAN3.numPaRamGroup[0] = 48;

DMANS3.tccAllocationMaskL = 0;
DMANS3.tccAllocationMaskH = 0xff;
DMAN3.numTccGroupl0] = 8;

Up to 8 QDMA channels
available on 644x

tcc’s are granted by bit mask |

if( this.prog.build.profile == "debug")
DMAN3.debug = true;
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For More Information

Codec Engine Information

Codec Engine Application Developer’'s Guide
Literature number: sprue67
http://focus.ti.com/lit/ug/sprue67c/sprue67c.pdf

Codec Engine Algorithm Creator User’s Guide
Literature number: sprued6
http://focus.ti.com/lit/ug/sprued6b/sprued6b.pdf

Codec Engine Server Integrator’s User’s Guide
Literature number: sprued5a.pdf
http://focus.ti.com/lit/ug/sprued5a/sprued5a.pdf

xDAIS-DM (Digital Media) User Guide
Literature number: spruec8
http://focus.ti.com/lit/ug/spruec8b/spruec8b.pdf

Information on Available Codecs

eXpressDSP Digital Media Software Product Bulletin
Literature Number: sprt390c
http://focus.ti.com/lit/ug/sprt390c/sprt390c.pdf

Davinci Software Book
Literature Number: sprt389
http://focus.ti.com/lit/ug/sprt389/sprt389.pdf

Tl Digital Media Software webpage
http://focus.ti.com/dsp/docs/dspsupporto.tsp?sectionld=3&tabld=1460
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For More Information

File Edit View

Favorites Tools Help

* 9 - N R | Psearch Frravorites £

applications

s > TM5320°

Information on Available Codecs

JPEG Imaging Encoder
TMDJPEGE, Status: ACTIVE

Texas Instruments

51 Alert me to changes
N o this product

& Description Support Software

& Available Updates
Compatibility Issues

@ Features
What's Included
JPEG Encoder Product Preview (sprt427.pdf, 456 KE)

28 Feb 2007 Download

® Technical Documents
Order Options
© Related Products

&4 Local intranet
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Lab 3a (DSP/BIOS version)

Lab 3a (DSP/BIOS version)

Important: Labs 2-4 of this workshop are presented in two versions, one utilizing DSP/BIOS
only (Lab 3a) for the operating system, and one utilizing VirtualLogix Linux and

DSP/BIOS executing concurrently (Lab 3b). You will only have time to complete
one version, so please choose the lab version appropriate for your system.

Lab3a jpeg loopthru Software Diagram

videol \I"FVID VIN driver
(*IVPFEQ")

echo (BIOS TSK)

Codec Engine

video

out 4._ FVID VOUT driver
(“/VPBEQ")

BIOS Operating System

In this lab, you will explore the Codec Engine framework via a loopthru demo application that

converts composite video input to the DM6437 DVEVM into JPEG-compressed images which
are then decoded and displayed on composite video output.
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Examine, Build and Test the Application
1. Start Code Composer Studio (if it is not already open) using the Desktop Shortcut

DM&5437 EVM
CCStudio v3.3

Note: you will need to make sure that the DM6437 dsk is connected (via USB emulation
cable) and powered on.

2. Load the video_preview.pjt project from the lab3a_copy_loopback directory

Project->open...

select video_preview.pjt from the C:\dm6437_1day\lab3a_copy_loopback folder.

3. Open and inspect the video_preview.c file

Locate the create_codec( ) function within video_preview.c

edit->find...

5. Examine the create_codec( ) function

Creation and configuration of a JPEG encoder instance is as simple as:

1.

2
3.
4

declaring and configuring the appropriate IMGENC_Params structure
declaring and configuring the appropriate IMGENC_DynamicParams structure
calling IMGENC_create with the configured (static) parameters structure

calling IMGENC_control with the XDM_SETPARAMS instruction and the dynamic
parameters structure to set the appropriate dynamic parameters

6. Locate the while loop within the video_preview function

The video_preview function is the main application task which drives the webcam
application. There is some setup before entering the while loop that you may be interested in
examining further at a later time, but for now, let’s focus on the main while loop.

The while loop uses the following structure:

1.
2.

FVID_exchange capture driver call to acquire an incoming video buffer

Configuration of the IMGENC_DynamicParams structure and setting of JPEG encoder’s
dynamic params through the IMGENC_control function with the XDM_SETPARAMS
command

Processing of the captured video frame via the IMGENC_process call

Cache writeback-invalidate on the output buffer (because it is stored in external memory
and the codec uses the DMA)

Repitition of steps 2-4, but for the JPEG Decoder

Displaying the resultant video buffer via FVID_exchange with the display driver
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7. Examine video_preview.cfg

Engine API
VISA API

Engine

The script begins by configuring the Operating System Abstraction Layer to support the
DSP/BIOS operating system. Next, the JPEG encoder and decoder modules are imported via
the xdc.usemodule( ) function. After that, the script imports the Engine module via the same
function and configures the Engine to contain the JPEG encoder and decoder, configuring
properties as appropriate.

Finally, the configuration script imports DSKT2 and DMAN3 modules as discussed during
the lecture, configuring them with the available memory and DMA resources for use by the
JPEG encoder and decoder when they are created.

8. Connect the DM6437 dsk (if not already connected)
Debug->Connect (Alt-C)

9. Configure CCS to use the xdc toolset

(Note, this should already be done on your lab setup, but you must be sure to do this step
when running the lab exercises at home.)

Help—>about...
Then select the Component Manager button

Within the Component Manager, navigate to the Target Content (XDC) branch and expand
the TMS320C64XX target. Be sure that the XDC toolset is selected as shown above.

10. Build the project
Project>Rebuild All

(You will get a number of warnings/remarks in the build output, but should get no build
errors.)

11. Load the video_preview.out executable onto the DM6437 DSK
File->Load Program... (Ctrl-L)

select video_preview.out from the Debug subfolder of the
C:\dm6437_1day\lab3a_copy_loopback directory.

12. Run the executable
Debug—~>Run (F5)
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13. Open the statistics window
DSP/BIOS -> Statistics View

Note the max and average values for the stsDatarate statistics object.

S5TS Count
TSE_ide 1]
previewT agk 0
IDL_busyObi 1.12854e+...
ztzD atarate 5593

-4.95506e+003
3.86588=+003

bl Average
2147483648 inst 0.00
2147483648 inst 0.00
-296 -439.067

B31200 B31200

The max and average datarate (between encoder and decoder) is 691,200 Bytes per frame.
This is because we are currently using a copy-based codec which does not actually encode
but simply copies the input buffer to the output buffer. This codec is very useful for testing
application setup before inserting a real codec as we are going to do in the next section.

The 691,200 Bytes per frame transferred corresponds to:
(720 pixels per line) * (480 lines) * (2 Bytes per pixel)

Frame size of a 4:2:2 YUV encoded standard definition frame

14. View the CPU load graph
DSP/BIOS - CPU Load Graph

Workshop Title - The Codec Engine



Lab 3a (DSP/BIOS version)

Insert JPEG Encoder

Because of the xXDM and VISA interface standards and the flexibility of the Codec Engine
framework, changing out two xDM-compliant codecs is as easy as modifying two lines in our
configuration file. This makes side-by-side comparison of codecs as well as upgrading codecs a
nearly trivial exercise.

15. Halt execution
Debug - Halt (shift-F5)

16. Reset the CPU
Debug - Reset CPU (ctrl-R)

17. Open the video_preview.cfg file

18. Modify the encoder and decoder module import lines to import the JPEG codec
Locate the following lines:
/* get various codec modules; 1.e., implementation of codecs */
var JPEGENC = xdc.useModule("codecs. imgenc_copy.IMGENC_ COPY™);
var JPEGDEC = xdc.useModule("codecs. imgdec_copy.IMGDEC_ COPY™);

and modify them to read:

/* get various codec modules; i1.e., implementation of codecs */
var JPEGENC = xdc.useModule("codecs. jpeg_enc.JPEG ENC");

var JPEGDEC = xdc.useModule("codecs. jpeg _dec.JPEG DEC");

Note that the codec module names (i.e. codecs.jpeg_dec.JPEG_DEC) are part of the
documentation provided with a delivered xXDM encoder or decoder.

19. Rebuild, load and run the application following steps 10-12 of the previous section

20. What differences do you notice in the data rate and CPU load graphs measured as per
steps 13 and 14 in the previous section

Note: You should right click in the statistics window and select “Clear” to clear the data
gathered from the copy-based codec in order to gather statistics just from the JPEG encoder.
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Modify JPEG Encoder Parameters

21.
22.

23.
24,

25.
26.

Halt the application if it is still running

Locate the dynamicParams.qValue parameter in video_preview.c within the while loop
of video preview()

Edit->Find... and select video_preview( )

Edit->Find... and select dynamicParams.qValue
Modify the gValue (quality value) from 73 to 1

Reset the CPU
Debug - Reset CPU (ctrl-R)

Rebuild, load and run the application as in step 19 of the previous section

Do you observe a change in the video output? How about the data rate and CPU load?

If you do not observe a noticeable difference, ask your instructor for help. Also, do not forget
to clear the statistics window to ensure that you are gathering only the statistics for the
current run.
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Lab 3b (Linux version)

Important: Labs 2-4 of this workshop are presented in two versions, one utilizing DSP/BIOS
only (Lab 3a) for the operating system, and one utilizing VirtualLogix Linux and

DSP/BIOS executing concurrently (Lab 3b). You will only have time to complete
one version, so please choose the lab version appropriate for your system.

Lab3c_jpeg loopthru Software Diagram

video] JI"FVID VIN driver | [ echo (BIOS TSK)
(“Idevival™)

Codec Engine

video
out FVID VOUT driver
4- (“/dev/fb/3") <

Linux Operating System

DSP/BIOS

Virtualogix VLX

In this lab, you will explore the Codec Engine framework via a loopthru demo application that

converts composite video input to the DM6437 DVEVM into JPEG-compressed images which
are then decoded and displayed on composite video output.
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Start the Linux Virtual Machine
1. Start the Red Hat Enterprise Linux 4 Virtual Machine (If not already started)

There is a shortcut on your desktop that will bring up the Virtual Machine information page

5."'1

Red Hat
Enterprize
Linux 4. vmx

Select “Start this virtual machine” from the information page

[P Start this virtual machine

2. Log in with user permissions

There are two Linux accounts set up:

user: user
password: useruser
user: root
password: rootpw

At times the instructions will ask you to switch to root permissions using the “su” (switch
user) command, but generally you should be logged in to the user account.

Configure Ethernet Port in Virtual Machine

3. Open a terminal window
right-click in the Redhat Linux desktop and select “Open Terminal”

4. Within the terminal you opened in step 3, use “su” command to switch to root
permission

# su

enter “rootpw” as the password when asked

5. Use the following procedure to configure the ethernet port with static IP address
192.168.1.40

# /sbin/ifconfig ethO down
# /sbin/ifconfig ethO 192.168.1.40
# /sbin/service nfs restart

6. Exit out of root permission (to user permission)
# exit
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Build the Linux-side Application

7. Change to the /home/user/workshop/lab3_jpeg_loopback directory
# cd /home/user/workshop/lab3_jpeg_loopback

8. Build and install the application via the provided script
# _/runmake._sh install

Boot Linux on the DM6437 DVEVM

9. Start Tera Term Pro from the Windows Desktop

LSS
Tera Term Pro

10. Start Code Composer Studio using the Windows Desktop Shortcut

CCStudio v3.3

Note: you will need to make sure that the DM6437 dsk is connected (via USB emulation
cable) and powered on.

We will use Code Composer Studio to load the linux kernel onto the DVEVM and boot.
Note, however, that the filesystem which Linux will use is a network share using the Network
File Share (nfs) filesystem, and the shared path is located within the Linux environment of
the virtual machine. When you ran the “make install” command in the previous section, the
make utility not only rebuilt the lab2_av.out applction, but copied it to this shared directory
so that it will be available to execute from the DVEVM board

11. Connect the DM6437 dsk
Debug—>Connect (Alt-C)

12. Load the server.pjt project in the lab3b_loopback_linux directory
Project->Open...
navigate to C:\dm6437_1day\labs\lab4b_webcam_linux

select server.pjt

13. Examine the mainTask function in main.c

Remember that the codec engine executes within the DSP/BIOS portion of the Virtuallogix
dual-operating system environment. This task function opens the Codec Engine and creates
an instance of the JPEG encoder contained in the Engine. It then loops within a while loop,
pending on the SEM_ShmEvent signal to indicate that a message has been received from the
Linux side via shared memory. When the message is received, the BIOS-side mainTask
function then decodes the message, calls IMGENC_process to encode the incoming buffer
with the JPEG encoder, and then returns the result using the nk_xirq_trigger function to send
a virtual interrupt back to the linux side.
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14. Examine video_preview.cfg

15.

16.

17.

18.

Engine API
VISA API

Engine

The script begins by configuring the Operating System Abstraction Layer to support the
DSP/BIOS operating system. Next, the codec modules are imported via the xdc.usemodule()
function. We will start with dummy copy-based codecs (provided with the Codec Engine for
test purposes), but in the next section, you will add in the JPEG encoder and decoder. After
that, the script imports the Engine module via the same function and configures the Engine to
contain the previously imported encoder and decoder, configuring properties as appropriate.

Finally, the configuration script imports DSKT2 and DMAN3 modules as discussed during
the lecture, configuring them with the available memory and DMA resources for use by the
JPEG encoder when it is created.

Rebuild the project
Project->Rebuild All

Reset the CPU

Debug—>Reset CPU (Ctrl-R)

Load the kernel, vix and BIOS executable onto the DM6437 DSK
File->Load Program... (Ctrl-L)

Navigate to C:\dm6437_1day\labs\lab3b_webcam_linux\Debug

Load each of the three executables in the following order:

nkern.out Virtuallogix vix virtualizer
vmlinux.out Linux kernel
server.out DSP/BIOS app and Bootloader program

note: the order is important because server.out needs to be loaded last so that the correct entry
point is set. The order of nkern and vmlinux don’t actually matter.

Run the program
Debug—~>Run (F5)

You should see feedback on the Terra Term serial terminal emulator as the Linux kernel
boots, ending with a login prompt:

192.168.1.40 login:

If the kernel feedback gives an error before reaching the login prompt, ask your instructor for
help.
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Run and view Application

19. Log into serial linux terminal as root user. No password is required.

20. Change to the /opt/workshop directory
# cd /opt/workshop

21. Load the audio and video driver modules with the loadmodules.sh script
# _/loadmodules._sh
note: if you would like to see the contents of this script, type:
# cat loadmodules.sh

22. Execute the lab3_loopback.out application
# ./1ab3_loopback.out

Insert JPEG Encoder

Because of the xDM and VISA interface standards and the flexibility of the Codec Engine
framework, changing out two xDM-compliant codecs is as easy as modifying two lines in our
configuration file.

23. Halt the Linux lab3_loopback.out application
Press ctrl-C in the serial terminal

24. Halt execution of the DM6437 within Code Composer Studio
Debug > Halt (shift-F5)

25. Reset the CPU (in CCS)
Debug - Reset CPU (ctrl-R)

26. Open the video_preview.cfg file
27. Modify the encoder and decoder module import lines to import the JPEG codec

Locate the following lines:

/* get various codec modules; i.e., implementation of codecs */
var JPEGENC = xdc.useModule("codecs.imgenc_copy. IMGENC_COPY*");
var JPEGDEC = xdc.useModule("codecs. imgdec_copy. IMGDEC_COPY");
and modify them to read:

/* get various codec modules; i.e., implementation of codecs */
var JPEGENC
var JPEGDEC

xdc.useModule("codecs. jpeg_enc.JPEG_ENC");

xdc.useModule("codecs. jpeg_dec.JPEG_DEC");

28. Rebuild, load and run the application following steps 15-18 and step 22 of the previous
section
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(Optional) Modify JPEG Encoder Parameters

29. Halt the application following steps 23 and 24 of the previous section

27. Locate the dynamicParams.qValue parameter in main.c of the server project in Code
Composer Studio. Make sure you find the gValue that is within the while loop of
video preview()

Edit>Find... and select video_preview( )
Edit->Find... and select dynamicParams.qValue

30. Modify the gValue (quality value) from 90 to 1 and save

31. In Code Composer Studio, Reset the CPU
Debug - Reset CPU (ctrl-R)

32. Rebuild, load and run the application as in step 28 of the previous section

33. Do you observe a change in the video output?

If you do not observe a noticeable difference, ask your instructor for help.
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Networking and Filesystem
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Multi-tasking, networking, resource management and other system issues can develop into
complex challenges, even for an engineer who is more in the know than Dilbert’s pointy haired
boss. Often these concerns are not system differentiators, simply entry-point development that is
required in order to bring a production-quality product to market.

This is why many Operating Systems provide a toolset for designers to use in managing these
system concerns. Effective utilization of the tools at a designer’s disposal can turn design years
into design months. This is why the DM6437 software framework includes two operating
systems: DSP/BIOS (a real-time operating system) and Linux (a general-purpose operating
system).

In this module we will compare and contrast the features of these two operating systems as well
as providing a basic introduction to how their various toolsets may be used in system
development.
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Module Topics

» Network Services (NDK)

» EMAC (NDK Socket I/F)

TMS320DM643x Software Overview

Operating System Layer (DSP BIOS and/or uC Linux)

Linux

An Operating System Tradeoff

DSP/BIOS

Linux provides a more generic hardware interface
Improved portability across platforms
Many available open-source applications

DSP/BIOS provides more direct hardware control
Improved hardware utilization / performance
Critical for MIPS-intensive signal processing
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What is DSP/BIOS?

Driver API
[reonaas | 4% £

API
DSP/BIOS | ¢4—p

MEM
module API
[Ram memory| +— «—
Scheduling

e Multi-tasking
Resource abstraction

« Drivers for peripherals
Resource allocation

» Arbitration between tasks
Debugging Toolset

* Real Time Data Exchange (RTDX)

What is Linux?

Driver API

[ rereras | £2%% £

File Sys Linux API

[some | 4 <
Kernel

API

Res Mgr
[RemEe| ~— —

Scheduling

e Multi-threading
Resource abstraction
e Drivers for peripherals
 Filesystems for storage devices
Resource allocation
» Protected access to resources
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Threads and Scheduling

Execution Threads

Option 1: Audio and Video in Option 2: Audio and Video in
a single thread separate threads
/l audio_video.c /[ audio.c, handles audio only

/I handles audio and video in int tski(int arge, char *argv[]) {

/I asingle thread while(condition == TRUE)
callAudioFxn();
int main(int argc, char *argv[]) }

{

while(condition == TRUE)X I/ video.c, handles video only
callAudioFxn();

callVideoFxn(); int tsk2(int arge, char *argv[]) {

while(condition == TRUE)
y } callVideoFxn();
}

Splitting into two threads is helpful if:

1) audio and video occur at different rates

2) audio and video should be prioritized differently

3) multiple channels of audio or video might be required (modularity)

Which Thread Runs?

Two common schemes for sharing CPU between threads:

Real Time Time Sliced
| o
! =)
! )

A system event drives a Multiple threads share
prioritized response CPU in round-robin circulation
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Time-Slice Scheduler

T

(niceness-5) | T

ProcessB [~ " " TR "~ I
(niceness 0)
Processc [ @A ___

(niceness+5) | T

Processes are time-sliced with more time given to
processes that are assigned a lower niceness value

Time-Slice Scheduler, >100% loading

U i — —

(niceness-5) | "

ThreadB | I -
(niceness 0)
Thread C ::::::::::::::::: % ______________ ::

(niceness +5)

# All threads share the pain of overloading, no thread has time
to complete all of its processing

+ Niceness values may be reconfigured, but system
indeterminism may cause future problems

¢ A good solution for non-realtime applications such as user
interface
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Real-Time Scheduler

Blocking call Thread unblocked (by driver)

Thread A bmmmms{----------—---------
(priority 3) [ -----mmmmmeeomoneae

e I s
(priority 2) Jr---------- .

Thread C |77 77777
(priority 1) [T e

The highest priority process runs until completion or
a blocking event

If external event of driver filling input buffer unblocks
Thread A, it will preempt lower priority threads

Note: Time-sliced threads may also block, taking
themselves out of rotation, but it is not required as
with real time threads

Real-Time Scheduler, >100% loading

Blocking call Thread unblocked (by driver)
Thread A -7~

(priority 3)
Thread B |-----—--—---

(priority 2) [---------- .

Thread C
(priority 1)

¢ Real-Time threads are scheduled according to priority

¢ The highest priority thread always “wins” and may cause low
priority threads not to run at all

¢ A good solution for real-time applications such as codecs
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Task Code Topology — Blocking Calls

Void taskFunction(...)
{

/I SI0 initialization
/I CE Initialization

while (‘condition’){

}
/I SIO cleanup
/I CE cleanup

AUDENC_process(myVE, ...);

/I Store Processed file

SIO_put(aiHandle, &bufPtr); =<— = Function blocks

thread execution
until new data is
available

Scheduling Methodologies

Time-Slicing with Blocking

Scheduler shares processor run time
between all threads with greater time
for higher priority

v' No threads completely starve

v Corrects for non-"good citizen”
threads

% Can't guarantee processor cycles
even to highest priority threads.

% More context switching overhead

Thread Blocking Only

Higher priority threads must
block for lower priority threads to
run

x Requires “good citizen” threads
% Low priority threads may starve

v' Lower priority threads never
break high priority threads

v Lower context-switch overhead

Linux Default

BIOS or
Linux R/T
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Resource Allocation

Dynamic Memory Allocation

DSP/BIOS MEM module allows DM6437
memory allocations from any
location in the DSP’s memory
map.
DSP/BIOS

Linux malloc can only allocate DM6437
memory from one system
heap, usually in external
memory. Internal memory
often provides a data cache.

Linux

Static memory allocation has the same limitations for Linux and
freedom for DSP/BIOS.

Peripherals Access

DSP/BIOS allows application DM6437
code to directly modify

peripheral registers. - -

DSP/BIOS

Linux requires a context DM6437
switch into kernel mode for
any peripheral access.

<

DSP/BIOS
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Linux: Protected, Portable Memory/Peripheral
Access

API

Driver
| Peripherals | +— <+ [ User Process 1 |
File SyS Linux API
[ somse | 45 <
Kernel

API

Res Mgr
[Ram Memory| +—» —

Protection

» Linux kernel acts as a proxy for process
requests to peripherals

Portability

* Less specificity in memory requests
allows greater portability across platforms.

DSP/BIOS: Efficient memory/peripheral access

Video Frame |

Algorithms may utilize DMA when processing data too large
to fit in internal memory. (More efficient than cache)

Linux does not allow user applications to request internal
versus external memory.

Linux driver latency (kernel mode context switch) limits the
efficiency of small DMA transfers.

DM6437 1-day - Networking and Filesystem



Networking Support

Networking Support

DVEVM Ethernet Support

¢ Supports 10/100 Mbit interface, sourcing the 25MHz clock
* MDIO PHY Address defaults to 0x00001

12C EEPROM

RJ-45 connector: | Address Contents
Green LED (link status/activity) 0x7F00 EMAC Address 0
Yellow LED (duplex mode) (most significant)
OXTFO1 EMAC Address 1
OX7FO2 EMAC Address 2
Micrel KS8001L PHY JETFS A1 |EMAG Addese s
interfaces to MIl peripheral i T Aodmes &
OXTFO5 EMAC Address 5

OX7FO6 Reserved
0x7FO7 Board Revision

_________________________________________ 5
1
I

i to allow PCI use and daughtercard EMAC use. i

Networking Stack

NDK (DSP/BIOS)

Telnet Server

DHCP Server and Client
DNS Server and Client
PPP Server and Client
PPPoE Server and Client
Virtual network w/ NAT
HTTP Server

TFTP Client

IGMP Client

L 2K 2K 2K 2R 2K 2R 2% 2% 2

Virtuallogix Linux

TCP/UDP

IPv4, IPv6

IP multicast

IP forwarding
DHCP/BOOTP/ RARP
IP tunneling

DiffServ, RSVP
RTP/RTSP

L 2R 2R 2R 2R 2R 2R 2R 2
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Filesystem Support

DDR2 Interface

TexAs Application Report
INSTRUMENTS SPRAACSC-November 2006

Implementing DDR2 PCB Layout on the TMS320DM644x

DMSoC
Michae! R, Shust, Kevin Jones High Speed HW Productization

8
5
=
o

|

* 128MBytes: two 512Mbit, 16-bit wide memories
* Clock Rates up to 166 MHz

« Supports both 84-ball and 92-ball package types

* Schematics and layout dictated by DDR2 PCB Layout App. Report

Asynchronous Memories

Jumper Select

—) NAND Flash (64MBytes)

EEPROMs

' o000
256Mbit 12C EEPROM ng [OO00] SPI EEPROM socket
containing DSP MAC e ] connected to McBSPO
address R ' interface
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NDK’s Embedded File System

EFS The embedded file system is the file I/O API that
is used by the HTTP server and several of the
example programs. Supports RAM files.

EFS_createfile Create a file from a RAM array
EFS_destroyfile Remove a file (if no open refs.)
EFS_fopen Open afile

EFS_fclose Close afile

EFS_fread Read from an open file
EFS_fwrite Write to an open file

EFS fseek Seek a position in open file

VirtualLogix Linux Supported File Systems

Media File systems:
ext3 Harddrive, Robust against unexpected power-down
vfat Harddrive, Windows FAT-32 compatible
msdos Harddrive, Windows FAT-16 compatible
iso 9660 CD-ROM filesystem

Memory File systems:
jffs Journaling flash filesystem
jffs2 Journaling flash filesystem (2" generation)
cramfs Compressed RAM filesystem

Special File systems:

nfs Share a remote linux filesystem
devfs Device driver filesystem
autofs Automatic filesystem mounting with timeout
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Accessing Files in Linux

Manipulating files from within user programs is as simple as...

File descriptor / handle Directory previously mounted  File to open... Permissions

« myFileFd = fopen(*“/mnt/harddrive/myfile”,”’rw”);
+« fread ( aMyBuf, sizeof(int), len, myFileFd );
+« fwrite( aMyBuf, sizeof(int), len, myFileFd );

. fclosi;fmyFileFd ); // //

i i ize of it #of it . )
Array to read into / write from size of item of items oo el

Additionally, use fprintf and fscanf for more feature-rich
file read and write capability
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VirtualLogix VLX

VirtualLogix VLX

An Operating System Tradeoff

Linux DSP/BIOS

Linux:

A very good operating system fit for general pupose
code, where portability and reliability requirements
outweigh performance

DSP/BIOS:

A very good operating system fit for signal
processing code, where performance is critical.

VirtualLogix VLX — The best of both worlds

DM643x Device

VLX allows application programmers to run Linux and DSP
BIOS simultaneously, combining the feature-rich Linux
environment with the DSP BIOS hard realtime scheduler
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VirtualLogix VLX

Inter-OS Communications

Shared Memory

Large buffers of data can be passed via pointer between
Linux and DSP/BIOS via a shared memory buffer

Cross Interrupts

Linux and DSP/BIOS may send virtual interrupts to each
other. Useful when passing buffers via shared memory.

Virtual Ethernet

Linux and DSP/BIOS applications can communicate as if
they were separate devices on an Ethernet Network.

Frame Buffer

Linux and DSP/BIOS applications may communicate as if
they were separate devices connected via a video port.

Virtual Console

A Linux application can print to a standard character
device, data is transmitted to DSP/BIOS side which
displays as a BIOS trace log via RTDX over JTAG (can be
displayed real time within Code Composer Studio).

When is VLX appropriate?

No

¢ Deeply embedded devices that operate autonomously
¢ Limited or no connectivity with outside world

¢ Limited or no user interface

¢ Real-time and general purpose computing requirements

¢ Alternative approach requires a General Purpose Processor
and DSP

Connected to the world

Requires a complex user interface

Requires fully-featured applications

Have software already running on a DM644x-based solution
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For More Information

For More Information

DSP/BIOS

DSP/BIOS Kernel Technical Overview
Literature Number: spra780
http://focus.ti.com/lit/an/spra780/spra780.pdf

TMS320C6000 DSP/BIOS User’s Guide
Literature Number: spru303b
http://focus.ti.com/lit/ug/spru303b/spru303b.pdf

TMS320C6000 DSP/BIOS API Reference Guide
Literature Number: spru404m
http:/ffocus.ti.com/lit/ug/spru404m/spru404m.pdf

DSP/BIOS Benchmarks, revision D
Literature Number: spraal6d
http://focus.ti.com/lit/an/spraal6d/spraal6d.pdf

TCP/IP Stack Documentation

TCP/IP Stack Getting Started Guide

The Getting Started Guide is a HTML based document providing up to date facts about the
current Stack release. This includes revision history, system requirements, up to date
documents, and current performance figures.

TCP/IP Stack User’s Guide (SPRU523)

The User’s Guide instructs the user on installing the Stack Software, going over the
example applications, and starting to write their own DSP based networking application. It
goes on to discuss how the Stack interacts with DSP/BIOS, and how to customize this
interaction.

TCP/IP Stack Programmer’s Reference Guide (SPRU524)

The Programmer’s Reference Guide is an API reference for all the Stack components. In
addition, there are some tutorial-like appendicles describing topics like PPP, NAT, and use
of the HTTP server. It documents the Hardware Adaptation Layer, but does not discuss
implementation.

TCP/IP Stack Platform Porting Guide (SPRU030)

The Porting Guide is used to move the stack from one C6000 based platform to another. It
documents the mini-driver API for the Hardware Adaptation Layer, and discusses the
method of porting device drivers.
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For More Information

VirtualLogix Information Pages

VirtualLogix Home page
http://www.virtuallogix.com/

VLX for Digital Multimedia Product Page
http://www.virtuallogix.com/index.php?id=21

VLXZone Support Page (patches, downloads, app notes, etc.)
http://www.virtuallogix.com/index.php?id=166
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Lab 4a (DSP/BIOS version)

Important: Labs 2-4 of this workshop are presented in two versions, one utilizing DSP/BIOS
only (Lab 4a) for the operating system, and one utilizing VirtualLogix Linux and
DSP/BIOS executing concurrently (Lab 4b). You will only have time to complete
one version, so please choose the lab version appropriate for your system.

Lab4a webcam_bios Software Diagram

video] \I"FVID VIN driver
(“VPFEQ")
e |FVID VOUT driver
(*\VPBEQ")

BIOS Operating System

echo (BIOS TSK)| |Codec Engine

In this lab, you will explore the networking capabilities of the DM6437 via a webcam demo
application that converts composite video input to the DM6437 DVEVM into JPEG-compressed
images which are displayed on the host via a webpage served from the DVEVM.

Examine the Application
1. Start Code Composer Studio (if it is not already open) using the Desktop Shorrtcut

CCStudio v3.3

Note: you will need to make sure that the DM6437 dsk is connected (via USB emulation
cable) and powered on.

2. Load the video_preview.pjt project from the lab4a_webcam_bios directory
Project->open...
select video_preview.pjt from the C:\dm6437_1day\lab4a_webcam_bios folder.
3. Examine the davinci.htm webpage file

Expand the Documents folder and double click on davinci.htm

Notice that in the header of the document, the webpage defines a JavaScript function called
refresh() which forces the webpage to reload the “pic.jpg” picture. Within the body, the
“pic.jpg” picture is placed on the document via the <img> tag. Within this tag, the onload

DM6437 1-day - Networking and Filesystem 4-19



Lab 4a (DSP/BIOS version)

field is used to call a function whenever the picture is loaded into the page. We set the
onload function to call setTimeout(), which instructs the page to call the refresh() function
after 100mS. Thus, after every 100mS, the user-defined refresh function will reload the
picture, which then triggers setTimeout() to run again. The result of this simple script is to
force a reload of pic.jpg ten times per second.

Note that most browsers will cache the picture so that even when the reload is forced, the old
(cached) version of the picture will be used. For this reason we will need to modify the
browser settings to force a reload. (See step 15 below)

Examine video_preview.c in the Source folder
Use the CCS search capability to search for “while”

This is the main while loop of the application. It begins with an FVID_exchange call to load a
new video buffer from the input driver. Next, IMGENC_control is used to set the desired
image quality and IMGENC _process is called to JPEG encode the video buffer. Finally, the
“efs_updatefilecb” function is called to update the pic.jpg file.

Recall that efs is the embedded filesystem provided with the Networking Development Kit
(NDK). This particular function updates pic.jpg with the newly encoded video frame.
efs_updatefilecb is not a standard efs function call. For the purposes of this lab, the
efs_createfilecb function was modified to allow a file to be updated without first being
deleted. The source code for this function is provided in “o0s” folder of the project directory.
All other efs function calls used are standard functions provided with the NDK.

Examine server.c

In this file we configure the html server. Use the CCS search feature to find the
“AddWebFiles” function. This function simply creates three new files using the efs_createfile
and efs_createfilecb functions. These are standard functions provided with the networking
development kit’s embedded file system (efs).

The efs_createfile functions take as their arguments a C array and size. The binsrc.exe utility
is used to convert files into C arrays. (See step 6 below)

Examine davinci.htm custom build options

Right click on davinci.htm in the project tree and select “File Specific Options...” The
window that is displayed shows a custom build command:

“$(Proj_dir)\binsrc.exe” davinci.htm default.c DEFAULT

This custom build command invokes the binsrc.exe utility, which is provided with the NDK
at $(NDK_INSTALL_DIR)\packages\ti\ndk\example\tools\common\binsrc

The command line options tell the utility to convert the text file davinci.htm into a standard C
file named default.c. The utility will create a C array containing the text of davinci.htm
converted to binary format. The name of the array is specified as the third argument, i.e.
DEFAULT.
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Build and Run the Application

7. Connect the DM6437 dsk (if not already connected)
Debug—>Connect (Alt-C)

8. Build the project
Project->Rebuild All

9. Load the video_preview.out executable onto the DM6437 DSK
File->Load Program... (Ctrl-L)

select video_preview.out from the Debug subfolder of the
C:\dm6437_1day\labda_webcam_bios directory.

10. Run the executable
Debug—->Run (F5)

11. Note the IP address displayed in the Standard Output window of CCS

ideo Preview Application -

CP-IP Stack Example Client
gtwork Added: If-1:192.165.1.41

Service Status: HITP ! Enabled : 0oo
Starting network...
', Build }, Stdout / K »

(This should always be 192.168.1.41 as it is statically assigned within the application)
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View the Webcam Page in Internet Explorer

12. Check the Windows routing table

Enter windows terminal mode via start->Run... and entering “cmd”

At the windows terminal command prompt, type:

c:\> route print

You should see feedback similar to the following (will differ depending on setup):

Select Command Prompt
int

. M5 TGP Loophack interface

58 56 cBA B8 @8
- 50 56 cB BB @1 ..
...88 18 8bh bha 3b Bb
ket Scheduler Miniport
@@ 1b fc ca 6f Ba ..

Hetmask
255.8.8.8
255.255.255.08

Gateuway
127.8.8.1
192.168.1.39
127.8.8.1
192.168.1.39
192.168.21.1

Interface
127.8.8.1
192.168.1.39
127.8.8.1
192.168.1.39
192.168.21 .1

.. UMuware Uirtual Ethernet Adapter for UMnet8
. UHware Uirtual Ethernet Adapter for UMnetl
Broadcom Netitreme 57xx Gigahit Controller — Pac

. Dell Wireless 1398 WLAM Mini-Card — Packet Sched

Metric
1

172.168.21.1
192.168.21.255
192.168.187.8
192.168.187.1
192.168.187.
224.8

127.8.8.1

192.168.21.1

192.168.187.1

127.8.8.1

192.168.187.1

192.168.1.379

192.168.21.1

192 .168.187.1

192.168.1.39 5
192.168.1.39 192.168.1.37
. 192.168.21.1

255 255 255,
255.255.255.
255.255.255.
255 .255.255.

255.255.255.
255.255.255.
255.255.255
4 5

The important entry in this case is the one that reads:

Destination: Netmask: Gateway: Interface

192.168.1.0 255.255.255.0 192.168.1.39 192.168.1.39

(For some lab setups, you may have a persistent route set specifically for destination
192.168.1.41)

This entry indicates that any IP request to the subnetwork 192.168.1.xxx (i.e. any address
which, when binary &-ed with the netmask 255.255.255.0, produces 192.168.1.0) will be
routed through the interface with IP address 192.168.1.39. Recall that 192.168.1.39 is the IP
address that has been statically assigned to the windows network connection to the DVDP
board.

If your network routing table is not properly set, you can add a routing entry via:

c:\> route add 192.168.1.41 192.168.1.39
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13. Test your network connection to the board via the ping utility
At the Windows terminal command prompt, type:
c:\> ping 192.168.1.41

You should see a feeback similar to the following:

c:srping 192 _168.1_41
Pinging 192.168.1.41 with 32 bytes of data:

Reply from 192_168_1_41: hytes=32 time<{ims TTL=255L
Reply from 192_168_1_41: hytes=32 time<{dims TTL=255L
Reply from 192.168.1.41: hytes=32 time<{ims TTL=255%
Reply from 192.168.1.41: bhytes=32 time<dims TTL=255

Ping statistics for 192.168.1_41:
Packets: Sent = 4, Received = 4, Lost = B <{Bx loss>,

Approximate round trip times in milli-seconds:
MHinimum = Bms,. Maximum = Bms,. Average = Bms

A

You can close the Windows terminal window when finished.

14. Open the Internet Explorer Web Browser and check the page refresh options

tools—> Internet Options...

Click the *“Settings” button under the Temporary Internet Files heading

15. Make sure the “Check for newer versions of stored pages”: option is set to “Every visit

to the page” as shown below:
f o 21X
Check for newer versions of stored pages:
& (g} Every visit to the page

C' Every time you start Internet Explorer
C' Automatically

O Never

Temporary Internet files folder

Current location: C:\Documents and
Settings\a0 193102 Local
Settings\Temporary Internet Files),
Amount of disk space to use:

v 595 3| MB

Move Folder... ][ View Files. .. ][ View Objects... ]

[ OK ] [ Cancel ]

16. Enter http://192.168.1.41 into the browser’s url locator
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We Hope You Have Had an Informative Day

OUR BONUSES WILL

DEPEND OM THE

| RESULTS OF THE

| EMPLOYEE ATTITUDE
SURVEY.

IF LJE BOOST OUR
MORALE RANK,
WE'LL GET BIGGER

| BONUSES. :

GET IT? ALL YOU HAVE
TO DO I5 SAY YOU'RE
HAPPY AND YOU GET

E-mall; SCOTTARAMES
=—

NO-0-0-01 HEAVEN BUT IF ¥OU DID LIE. TLL HAND OUT THE
FORBID. ABSOLUTELY IMAGIME THE THINGS SURVEYS AMD YOU
|| NOLYING. YOU COULD BUY WITH | CAN LET YOUR CON-

IS PARA-
DISE TOO
OVER THE

I'™M GOING
TO LIE ME
UP A NEW
COUCH!

THAT MONEY. SCIEMCE GUIDE YOuU.

& UFS, Inc.

Please do not forget to fill out an evaluation of the DM6437 1-day workshop before you leave.
Your feedback is crucial in helping us improve our course materials.

If you have not been provided with instructions for filling out an evaluation, please ask your
instructor.
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Lab 4b (Linux version)

Important: Labs 2-4 of this workshop are presented in two versions, one utilizing DSP/BIOS
only (Lab 4a) for the operating system, and one utilizing VirtualLogix Linux and
DSP/BIOS executing concurrently (Lab 4b). You will only have time to complete
one version, so please choose the lab version appropriate for your system.

Lab4b _webcam linux Software Diagram

video] JI"FVID VIN driver | [ echo (BIOS TSK)|| || Codec Engine
("IVPFEQ")

]
video .
L_|FVID VOUT driver
outey (* VPBEQ”) L

Linux Operating System

DSP/BIOS

Virtualogix VLX

In this lab, you will explore the Codec Engine framework via a webcam demo application that

converts composite video input to the DM6437 DVEVM into JPEG-compressed images which
are displayed on the host via a webpage served from the DVEVM.
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Start the Linux Virtual Machine
1. Start the Red Hat Enterprise Linux 4 Virtual Machine (If not already started)
There is a shortcut on your desktop that will bring up the Virtual Machine information page

5."'1

Red Hat
Enterprize
Linux 4. wmx

Select “Start this virtual machine” from the information page
[:} Start this virtual machine

2. Log in with user permissions
There are two Linux accounts set up:

user: user
password: useruser
user: root
password: rootpw

At times the instructions will ask you to switch to root permissions using the “su” (switch
user) command, but generally you should be logged in to the user account.

3. Open a terminal window
right-click in the desktop and select “Open Terminal”

4. Within the terminal window use “su” command to switch to root permission
# su

enter “rootpw” as the password when asked

5. Use the following procedure to configure the virtual machine’s network connection with
static IP address 192.168.1.40

# /sbin/ifconfig ethO down
# /sbin/ifconfig ethO 192.168.1.40

# /sbin/service nfs restart

6. Exit out of root permission (to user permission)
# exit

4-26 DM6437 1-day - Networking and Filesystem



Lab 4b (Linux version)

Examine and Build the Linux-side Application

7. Change to the /home/user/workshop/lab4_webcam directory
# cd /home/user/workshop/lab4_webcam

8. Examine the davinci.htm webpage file in the websrc folder

# gedit websrc/davinci.htm

Notice that in the header of the document, the webpage defines a JavaScript function called
refresh() which forces the webpage to reload the “pic.jpg” picture. Within the body, the
“pic.jpg” picture is placed on the document via the <img> tag. Within this tag, the onload
field is used to call a function whenever the picture is loaded into the page. We set the
onload function to call setTimeout(), which instructs the page to call the refresh() function
after 100mS. Thus, after every 100mS, the user-defined refresh function will reload the
picture, which then triggers setTimeout() to run again. The result of this simple script is to
force a reload of pic.jpg ten times per second.

Note that most browsers will cache the picture so that even when the reload is forced, the old
(cached) version of the picture will be used. For this reason we will need to modify the
browser settings to force a reload.

9. Build and install the application via the provided script

# ./runmake.sh install
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Boot Linux on the DM6437 DVEVM

10.

11.

12.

13.

14.

15.

16.

Start Tera Term Pro from the Windows Desktop

L=
Tera Term Pro

Start Code Composer Studio using the Windows Desktop Shortcut

2]
CCStudio v3.3

Note: you will need to make sure that the DM6437 dsk is connected (via USB emulation
cable) and powered on.

We will use Code Composer Studio to load the linux kernel onto the DVEVM and boot.
Note, however, that the filesystem which Linux will use is a network share using a Network
File Share (nfs) filesystem located within the Linux environment of the virtual machine.

Connect the DM6437 dsk
Debug—>Connect (Alt-C)

Load the server.pjt project in the lab4b_webcam_linux directory
Project>Open...
navigate to C:\dm6437_1day\lab4b_webcam_linux

select server.pjt
Rebuild the project
Project->Rebuild All

Reset the CPU
Debug—~>Reset CPU (Ctrl-R)

Load the kernel, vix and BIOS executable onto the DM6437 DSK
File->Load Program... (Ctrl-L)

Navigate to C:\dm6437_1day\lab4b_webcam_linux\Debug

Load each of the three executables in the following order:

nkern.out Virtuallogix vix virtualizer
vmlinux.out Linux kernel
server.out DSP/BIOS app and Bootloader program

note: the order is important because server.out needs to be loaded last so that the correct entry
point is set. The order of nkern and vmlinux don’t actually matter.

DM6437 1-day - Networking and Filesystem



Lab 4b (Linux version)

17. Run the program
Debug—~>Run (F5)
You should see feedback as the Linux kernel boots, ending with a login prompt:
192.168.1.41 login:

If the kernel feedback gives an error before reaching the login prompt, ask your instructor for
help.

Run the Application
18. Log into serial linux terminal as root user, no password

19. Change to the /opt/workshop directory
# cd /opt/workshop

20. Load the audio and video driver modules with the loadmodules.sh script
# _/loadmodules.sh
note: if you would like to see the contents of this script, type:

# cat loadmodules.sh

21. Execute the lab4_html.out application
# ./lab4_html _out
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View Webcam Page in Internet Explorer

17. Check the Windows routing table

Enter windows terminal mode via start->Run... and entering “cmd”

At the windows terminal command prompt, type:

c:\> route print

You should see feedback similar to the following (will differ depending on setup):

Select Command Prompt
int

. M5 TGP Loophack interface

58 56 cBA B8 @8
- 50 56 cB BB @1 ..
...88 18 8bh bha 3b Bb
ket Scheduler Miniport
@@ 1b fc ca 6f Ba ..

Hetmask
255.8.8.8
255.255.255.08

Gateuway
127.8.8.1
192.168.1.39
127.8.8.1
192.168.1.39
192.168.21.1

Interface
127.8.8.1
192.168.1.39
127.8.8.1
192.168.1.39
192.168.21 .1

.. UMuware Uirtual Ethernet Adapter for UMnet8
. UHware Uirtual Ethernet Adapter for UMnetl
Broadcom Netitreme 57xx Gigahit Controller — Pac

. Dell Wireless 1398 WLAM Mini-Card — Packet Sched

Metric
1

172.168.21.1
192.168.21.255
192.168.187.8
192.168.187.1
192.168.187.
224.8

127.8.8.1

192.168.21.1

192.168.187.1

127.8.8.1

192.168.187.1

192.168.1.379

192.168.21.1

192 .168.187.1

192.168.1.39 5
192.168.1.39 192.168.1.37
. 192.168.21.1

255 255 255,
255.255.255.
255.255.255.
255 .255.255.

255.255.255.
255.255.255.
255.255.255
4 5

The important entry in this case is the one that reads:

Destination: Netmask: Gateway: Interface

192.168.1.0 255.255.255.0 192.168.1.39 192.168.1.39

(For some lab setups, you may have a persistent route set specifically for destination
192.168.1.41)

This entry indicates that any IP request to the subnetwork 192.168.1.xxx (i.e. any address
which, when binary &-ed with the netmask 255.255.255.0, produces 192.168.1.0) will be
routed through the interface with IP address 192.168.1.39. Recall that 192.168.1.39 is the IP
address that has been statically assigned to the windows network connection to the DVDP
board.

If your network routing table is not properly set, you can add a routing entry via:

c:\> route add 192.168.1.41 192.168.1.39
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18. Test your network connection to the board via the ping utility
At the Windows terminal command prompt, type:
c:\> ping 192.168.1.41

You should see a feeback similar to the following:

c:srping 192 _168.1_41
Pinging 192.168.1.41 with 32 bytes of data:

Reply from 192_168_1_41: hytes=32 time<{ims TTL=255L
Reply from 192_168_1_41: hytes=32 time<{dims TTL=255L
Reply from 192.168.1.41: hytes=32 time<{ims TTL=255%
Reply from 192.168.1.41: bhytes=32 time<dims TTL=255

Ping statistics for 192.168.1_41:
Packets: Sent = 4, Received = 4, Lost = B <{Bx loss>,

Approximate round trip times in milli-seconds:
MHinimum = Bms,. Maximum = Bms,. Average = Bms

A

You can close the Windows terminal window when finished.

19. Open the Internet Explorer Web Browser and check the page refresh options

tools—> Internet Options...

Click the *“Settings” button under the Temporary Internet Files heading

20. Make sure the “Check for newer versions of stored pages”: option is set to “Every visit

to the page” as shown below:
f o 21X
Check for newer versions of stored pages:
& (g} Every visit to the page

C' Every time you start Internet Explorer
C' Automatically

O Never

Temporary Internet files folder

Current location: C:\Documents and
Settings\a0 193102 Local
Settings\Temporary Internet Files),
Amount of disk space to use:

v 595 3| MB

Move Folder... ][ View Files. .. ][ View Objects... ]

[ OK ] [ Cancel ]

22. Browse the http://192.168.1.41/davinci.htm url
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We Hope You Have Had an Informative Day
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OVER THE
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& UFS, Inc.

Please do not forget to fill out an evaluation of the DM6437 1-day workshop before you leave.
Your feedback is crucial in helping us improve our course materials.

If you have not been provided with instructions for filling out an evaluation, please ask your
instructor.
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